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Terms for Included Open 
Source Software 
This SAP software contains also the third party open source software 
products listed below. Please note that for these third party products 
the following special  terms and conditions shall apply. 
 

 

SAP License Agreement for STLport  
SAP License Agreement for STLport 

between 
 

SAP Aktiengesellschaft 
Systems, Applications, Products in Data Processing 

Neurottstrasse 16 
69190 Walldorf 

Germany 
( hereinafter: SAP ) 

 
and 

 
you 

( hereinafter: Customer ) 
 
 
1. Subject Matter of the Agreement 

a. SAP grants Customer a non-exclusive, non-transferable, 
royalty-free license to use the STLport.org C++ library 
(STLport) and its documentation without fee. 

b. By downloading, using, or copying STLport or any portion 
thereof Customer agrees to abide by the intellectual property 
laws, and to all of the terms and conditions of this 
Agreement. 

c. The Customer may distribute binaries compiled with 
STLport (whether original or modified) without any 
royalties or restrictions. 

d. Customer shall maintain the following copyright and 
permission notices on STLport sources and its 
documentation unchanged: 
Copyright 2001 SAP AG 

e. The Customer may distribute original or modified STLport 
sources, provided that: 
• The conditions indicated in the above permission notice 

are met; 
• The following copyright notices are retained when 

present, and conditions provided in accompanying 
permission notices are met: 

 
Copyright 1994 Hewlett-Packard Company 
Copyright 1996,97 Silicon Graphics Computer 
Systems, Inc. 
Copyright 1997 Moscow Center for SPARC 
Technology. 
Copyright 1999,2000 Boris Fomitchev 
Copyright 2001 SAP AG 
 
Permission to use, copy, modify, distribute and sell this 
software and its documentation for any purpose is 
hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in 
supporting documentation. Hewlett-Packard Company 
makes no representations about the suitability of this 
software for any purpose. It is provided "as is" without 
express or implied warranty. 
 
Permission to use, copy, modify, distribute and sell this 
software and its documentation for any purpose is 
hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in 
supporting documentation. Silicon Graphics makes no 
representations about the suitability of this software for 
any purpose. It is provided "as is" without express or 
implied warranty. 
 
Permission to use, copy, modify, distribute and sell this 
software and its documentation for any purpose is 
hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in 
supporting documentation. Moscow Center for SPARC 



 

Technology makes no representations about the 
suitability of this software for any purpose. It is 
provided "as is" without express or implied warranty. 
 
Boris Fomitchev makes no representations about the 
suitability of this software for any purpose. This 
material is provided "as is", with absolutely no 
warranty expressed or implied. Any use is at your own 
risk. Permission to use or copy this software for any 
purpose is hereby granted without fee, provided the 
above notices are retained on all copies. Permission to 
modify the code and to distribute modified code is 
granted, provided the above notices are retained, and a 
notice that the code was modified is included with the 
above copyright notice. 
 
Permission to use, copy, modify, distribute and sell this 
software and its documentation for any purpose is 
hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in 
supporting documentation. SAP makes no 
representations about the suitability of this software for 
any purpose. It is provided with a limited warranty and 
liability as set forth in the License Agreement 
distributed with this copy. SAP offers this liability and 
warranty obligations only towards its customers and 
only referring to its modifications. 

 
2. Support and Maintenance 

SAP does not provide software maintenance for the STLport. 
Software maintenance of the STLport therefore shall be not 
included. 
All other services shall be charged according to the rates for 
services quoted in the SAP List of Prices and Conditions and 
shall be subject to a separate contract. 

3. Exclusion of warranty 
As the STLport is transferred to the Customer on a loan basis and 
free of charge, SAP cannot guarantee that the STLport is error-
free, without material defects or suitable for a specific application 
under third-party rights. Technical data, sales brochures, 
advertising text and quality descriptions produced by SAP do not 
indicate any assurance of particular attributes. 

4. Limited Liability 
a. Irrespective of the legal reasons, SAP shall only be liable for 

damage, including unauthorized operation, if this (i) can be 
compensated under the Product Liability Act or (ii) if caused 
due to gross negligence or intent by SAP or (iii) if based on 
the failure of a guaranteed attribute. 

b. If SAP is liable for gross negligence or intent caused by 
employees who are neither agents or managerial employees 
of SAP, the total liability for such damage and a maximum 
limit on the scope of any such damage shall depend on the 
extent to which its occurrence ought to have anticipated by 
SAP when concluding the contract, due to the circumstances 
known to it at that point in time representing a typical 
transfer of the software. 

c. In the case of Art. 4.2 above, SAP shall not be liable for 
indirect damage, consequential damage caused by a defect or 
lost profit. 

d. SAP and the Customer agree that the typical foreseeable 
extent of damage shall under no circumstances exceed EUR 
5,000. 

e. The Customer shall take adequate measures for the 
protection of data and programs, in particular by making 
backup copies at the minimum intervals recommended by 
SAP. SAP shall not be liable for the loss of data and its 
recovery, notwithstanding the other limitations of the present 
Art. 4 if this loss could have been avoided by observing this 
obligation. 

f. The exclusion or the limitation of claims in accordance with 
the present Art. 4 includes claims against employees or 
agents of SAP. 

 



 

Typographic Conventions 
 

Type Style  Represents 

Example Text Words or characters that 
appear on the screen. These 
include field names, screen 
titles, pushbuttons as well as 
menu names, paths and 
options. 

Cross-references to other 
documentation 

Example text Emphasized words or phrases 
in body text, titles of graphics 
and tables 

EXAMPLE TEXT Names of elements in the 
system. These include report 
names, program names, 
transaction codes, table 
names, and individual key 
words of a programming 
language, when surrounded by 
body text, for example, 
SELECT and INCLUDE. 

Example text Screen output. This includes 
file and directory names and 
their paths, messages, names 
of variables and parameters, 
source code as well as names 
of installation, upgrade and 
database tools. 

Example text Exact user entry. These are 
words or characters that you 
enter in the system exactly as 
they appear in the 
documentation. 

<Example 
text> 

Variable user entry. Pointed 
brackets indicate that you 
replace these words and 
characters with appropriate 
entries. 

EXAMPLE TEXT Keys on the keyboard, for 
example, function keys (such 
as F2) or the Enter key. 

Icons 
 

Icon Meaning 

 
Caution 

 
Example 

 
Note 

 
Recommendation 

 
Syntax 
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 SAP J2EE Engine Installation for 
SAP Systems on Windows: MS SQL 
Server 
Purpose 
This documentation explains how to install the SAP J2EE Engine for already existing SAP 
systems (based on SAP Web Application Server) on Windows when your database is MS 
SQL Server. 

SAP Web Application Server (SAP Web AS) is the underlying technology of almost all 
solutions of mySAP Business Suite. For more information on the technology provided by SAP 
Web AS, see the SAP Service Marketplace at the Internet address:  
service.sap.com/netweaver 

 

 
Before you start your installation, make sure that you read the Installation 
Checklists [Page 16]. This section of the documentation provides you with a 
list of all actions that you must perform to install your SAP system 
successfully. The actions are listed chronologically in checklists, which you 
use to navigate through the installation. 

Constraints 

 
You must only use the SAP installation tools according to the instructions and 
for the purposes described in the SAP installation documentation. Improper 
use of the SAP installation tools can damage files and systems already 
installed. 

You need consider the following constraints before you start your installation: 

• This documentation only applies if you are installing an MS SQL Server database with 
a Windows operating system. 

• SAP system installations should only be performed by SAP Technical Consultants, 
who are certified for your operating system, your database, and the SAP system that 
you are installing. 
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1  General Information  
• For the installation of the J2EE Engine on Windows, only the English international 

version of Windows 2000 or Windows Server 2003 are supported.  

• Before you start the SAP system installation, read Installation Checklists [Page 16]. 

1.2  Naming Conventions 
In this documentation, the following naming conventions apply: 

Variables 
Variables Description 
<SAPSID> SAP system ID in uppercase letters 

<sapsid> SAP system ID in lowercase letters 

<DBSID> Database ID in uppercase letters 

<dbsid> Database ID in lowercase letters 

<host_name> Name of the corresponding host 

<SAPinst_INSTDIR> Installation directory for the SAP installation tool SAPinst 

<INSTDIR> Installation directory for the SAP system 

<CD-DIR> Directory on which a CD is mounted 

<OS> Operating system name within a path 

 

The following examples show how the variables are used: 

 
• Log on as user <sapsid>adm and change to the directory 

\usr\sap\<SAPSID>. 
If your SAP system ID is C11, log on as user c11adm and change to 
the directory \usr\sap\C11. 

• Change to the directory <CD-DIR>\Windows\<OS>. 
If the CD is mounted on \sapcd1 and your operating system is 
Windows NT, change to \sapcd1\Windows\NT. 
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2  Implementation Considerations 
Purpose 
You and your hardware partner generally plan the system configuration well in advance of the 
installation, using sizing information that reflects the system workload. You use factors such 
as the following to design a configuration that performs well: 

• The required applications 

• How intensively the applications are to be used 

• The number of users 

 
As the system configuration fundamentally influences the installation 
procedure, it is important to have a clear configuration plan before you start 
the installation.  

Process Flow 
... 

1. You choose the basic system variant [Page 10] of SAP Web AS. 

2. You choose the required installation components [Page 10]. 

3. You decide how to distribute the required installation components to the available 
hosts. This depends on your basic installation type: 

 
Beside component distributions shown in the sections listed below, also all 
other distributions in between these minimal and maximal component 
distributions are possible. 

{ Distribution of Installation Components for an SAP Web AS ABAP+J2EE system 
[Page 12] 

{ Distribution of Installation Components for an SAP Web AS J2EE system [Page 
14] 

2.1  Basic System Variants 
There are the following basic system variants of SAP Web Application Server (and SAP 
systems based on SAP Web Application Server): 

• SAP systems based on an SAP Web AS ABAP+J2EE system 

This system variant consists of the ABAP installaton of an SAP system and the SAP 
J2EE Engine. You can then operate both the ABAP Engine and the SAP J2EE Engine 
on the SAP system. 

• SAP Web AS J2EE system 

This system variant consists of the SAP J2EE Engine and auxiliary services. There is 
no ABAP Engine. 
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2.2  Installation Components 
Definition 
A minimum SAP system consists of a central instance, a central services instance, and a 
database instance. You can then install optional dialog instances on different hosts after you 
have completed the installation of the central instance, the central services instance, and the 
database. 

 
You can think of an SAP instance – central instance, central services 
instance, database instance, dialog instance, or gateway instance – as a 
group of processes that are started and stopped at the same time. Every 
instance has a two-digit identifier between 00 and 97 that must be unique on a 
computer. 

Use 
When you set up an SAP system, you need to install the main components that enable the 
system to operate: 

• Central Instance 

The Software Deployment Manager (SDM) is part of the SAP J2EE Engine of the 
central instance. For more information, see section Additional Information about the 
SAP J2EE Engine [Page 93]. 

• Central services instance 

SAP Central Services (SCS) form the basis of communication and synchronization for 
the J2EE cluster. A central services instance consists of the message service and the 
enqueue service: 

{ The message service keeps a list of the J2EE dispatchers and J2EE server 
processes of the J2EE cluster. It provides the infrastructure for data exchange 
(small datasets only) between the participating nodes. The message service 
also supplies information to the SAP Web Dispatcher about load balancing 
between multiple J2EE instances. 

{ The enqueue service manages logical database locks, which are set by the 
executed application program in a J2EE server process. The enqueue service 
also synchronizes data across the J2EE cluster. 

For more information, see the following in the SAP Library [Page 31]: 

J2EE Technology in SAP Web Application Server → Architecture Manual → J2EE 
Cluster Architecture → Central Services 

• Database instance 

As of SAP Web AS 6.30, the SAP J2EE Engine has its own database schema. 
Therefore, a database instance is also a mandatory installation component for the 
installation of an SAP Web AS J2EE system. 

For the installation of an SAP Web AS ABAP+J2EE system, both the ABAP and the 
J2EE schema are installed in the same database. 

• Dialog instances, if required 

Dialog instances are SAP instances that include only the dispatcher, J2EE server 
processes, and – if you install SAP Web AS – the gateway and certain ABAP work 
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processes (dialog, batch, spool, or update). Dialog instances are installed on 
application servers. 

The dialog instances of an SAP Web AS J2EE system are called J2EE dialog 
instances. 

 
If information is valid for both dialog instances and J2EE dialog instances, 
(J2EE) dialog instance is written in this documentation. 

• Gateway instance, if required 

It is possible to install an SAP instance of an SAP Web AS (ABAP) exclusively as a 
standalone gateway. This type of instance does not contain normal work process types 
(dialog, background, update, enqueue or spool). Only the gateway process (gwrd) is 
started. If there is an SNA connection to an R/2 System, gateway work processes 
(gwwp) are also started. 

As gateway instances are only part of an SAP Web AS (ABAP) installation, they are 
not described in this installation documentation. 

• Front ends 

The installation of front ends for the SAP system is described separately in the 
documentation [Page 30] SAP Front End Installation Guide. 

• SAP NetWeaver Developer Workplace 

The SAP NetWeaver Developer Workplace consists of a special SAP Web AS J2EE 
system in addition to the SAP NetWeaver Developer Studio, SAP’s Java Integrated 
Development Environment (IDE). If required, you can install the Java IDE separately. 

 
The installation of the SAP NetWeaver Developer Workplace is not described 
in this installation documentation. For its installation, see the documentation 
[Page 30] Installation Guide – SAP NetWeaver Developer Workplace. 

• SAP NetWeaver Developer Studio 

The SAP NetWeaver Developer Studio is SAP’s own environment for developing Java-
based, multi-layered business applications. The new development environment is 
based on Eclipse, an open source product. The open plug-in architecture of Eclipse 
provides a suitable platform for incorporating specific functions.  

For more information, see the following in the SAP Library [Page 31]: 

J2EE Technology in SAP Web Application Server → Development Manual → 
Introduction to the SAP NetWeaver Developer Studio 

You can install the SAP NetWeaver Developer Studio in either of the following ways: 

{ Separately 

For more information, see the documentation [Page 30] Installation Guide – 
SAP NetWeaver Developer Studio. 

{ As part of the SAP NetWeaver Developer Workplace 

For more information, see the documentation [Page 30] Installation Guide – 
SAP NetWeaver Developer Workplace. 

2.3  Distribution of Installation Components 
for an SAP Web AS ABAP+J2EE System 
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You decide if you want to distribute the SAP system instances on a single host or on multiple 
hosts: 

• SAP J2EE Engine for a central SAP system installation 

The central instance and the database instance of your SAP system are installed on a 
single host and you want to install the central services instance on this host as well. 

Existing SAP System

Central Scenario

Central + Database
Instance Host

Database

ABAP Schema

Central Instance

ABAP
Engine

Central + Database + 
Central Services Instance 

Host

Database

Central Instance

ABAP
Engine

SAP J2EE
Engine

J2EE Schema

ABAP Schema

Central Services 
Instance

SAP J2EE 
Engine

Installation 
for a

Central
SAP 

System

Distribution before
the installation of the

SAP J2EE Engine

Distribution after
the installation of the

SAP J2EE Engine

 
• SAP J2EE Engine for a distributed SAP system installation 

Central instance, central services instance and database instance of your SAP system 
are installed on multiple hosts. 
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Existing SAP System

Distributed Scenario I

Central + Database
Instance Host

Database

ABAP Schema

Central Instance

ABAP
Engine

Central + Database 
Instance Host

Database

Central Instance

ABAP
Engine

SAP J2EE
Engine

J2EE Schema

ABAP Schema

SAP J2EE 
Engine

Installation 
for a

Distributed
SAP 

System
Central Services

Instance Host

Central Services 
Instance

Existing SAP System

Distributed Scenario II

Central Instance Host

Central Instance

ABAP
Engine

SAP J2EE 
Engine

Installation 
for a

Distributed
SAP 

System

Distribution before
the installation of the

SAP J2EE Engine

Distribution after
the installation of the 

SAP J2EE Engine

Central Services
Instance Host

Central Services 
Instance

Database Instance Host

Database

ABAP Schema

Distributed Scenario III Distributed Scenario IV

Central Instance Host

Central Instance

ABAP
Engine

Database Instance Host

Central + Central 
Services Instance Host

Central Instance

ABAP
Engine

Database Instance Host

Central Instance Host

Central Instance

ABAP
Engine

Database + Central 
Services Instance Host

Central Services 
Instance

SAP J2EE
Engine SAP J2EE

Engine

SAP J2EE
Engine

Database

J2EE Schema

ABAP Schema Database

J2EE Schema

ABAP Schema

Database

J2EE Schema

ABAP Schema

Central Services 
Instance

 



  2   Implementation Considerations 

  2.4   Distribution of Installation Components for an SAP Web AS J2EE System 

October 2003 15 

2.4  Distribution of Installation Components 
for an SAP Web AS J2EE System 
All mandatory installation components [Page 10] for the SAP Web AS J2EE system 
installed on a single host. 

 
There is no distributed installation for the SAP Web AS 6.30 J2EE system. 

One Host Installation of an SAP Web AS J2EE System

Central Services
Instance

Central Instance

SAP J2EE
Engine

J2EE SchemaJ2EE Schema

Database Instance
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3  Installation Checklists 
Purpose  
You use the tables in the following sections as checklists to navigate through the installation 
when you install your SAP system.  

Prerequisites 
You have decided how to implement your SAP system [Page 10]. 

Process Flow 
... 

1. You choose and print out the relevant installation checklist(s) for one of the following 
system variants: 

{ SAP Web AS J2EE system 

If you want to install the system variant SAP Web AS J2EE system, you have to 
perform the installation option SAP Web AS – J2EE only. 

Installation Option Installation Checklist 

Installation of SAP Web AS – J2EE only as a 
central system: 

Central instance, central services instance 
and database instance of the SAP Web AS 
J2EE system are installed on one host 

SAP Web AS – J2EE only 
(Central System) [Page 17] 

Installation of J2EE Dialog Instance(s) for the 
SAP Web AS J2EE system  

J2EE Instance for SAP 
Web AS – J2EE only [Page 
19] 

 

{ SAP Web AS ABAP+J2EE system 

If you want to install the system variant SAP Web AS ABAP+J2EE system, you 
have to perform the installation option SAP Web AS – J2EE Add-In that adds an 
SAP J2EE Engine to an existing SAP Web AS 6.20 (ABAP) SP 25 or higher.  

The installation of SAP Web AS 6.20 (ABAP) is not included in this installation 
option. As a result, SAP Web AS 6.20 (ABAP) SP25 or higher is a prerequisite 
for this installation. 

Installation Option Installation Checklist 

Installation of SAP Web AS – J2EE Add-In 
as a central system: 

Central instance, central services and 
database instance of the SAP Web AS 
ABAP+J2EE system are installed on one 
host 

SAP Web AS – J2EE Add-
In as Central System [Page 
20] 

Installation of SAP Web AS – J2EE Add-In 
as a distributed system: 

Central instance, central services and 
database instance of the SAP Web AS 
ABAP+J2EE system are installed on 
multiple hosts 

SAP Web AS – J2EE Add-
In as Distributed System 
[Page 23] 
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Installation Option Installation Checklist 

Installation of dialog instance(s) for the SAP 
Web AS ABAP+J2EE system 

Dialog Instance for SAP 
Web AS – J2EE Add-In 
[Page 26] 

You might need to refer to the sections listed under Additional Information [Page 28] 
when installing your SAP system. 

2. You follow the installation sequence exactly as shown in the checklists: 
... 

a. If a step is required for your installation, you follow the link for that step to the 
corresponding section. 

b. You perform the procedure described there. 

c. After successfully completing the installation step, you mark the corresponding 
entry in the printed table with ! to log the progress of your installation. 

d. You proceed with the next step listed in the checklist. 

3.1  Installation Checklists for the SAP Web 
AS J2EE System 

3.1.1  Installation Checklist for SAP Web AS – J2EE 
only (Central System) 
Purpose 
You use the following checklist when you want to install SAP Web AS – J2EE only on a 
single host. 

 
There is no distributed installation for the SAP Web AS 6.30 J2EE system. 

Prerequisites 
You have planned the system configuration as described in Implementation Considerations 
[Page 10]. 

Process Flow 

Installation Planning 
! Action 

 You obtain the required documentation [Page 29].  

 You decide if you want to install install multiple components in one database 
(MCOD) [Page 32]. 

 
Be aware that you cannot install a Unicode SAP system with a non-
Unicode SAP system in one database (MCOD). 

 You decide on the optimal system configuration [Page 36]. 
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 You check the hardware and software requirements [Page 43]. 

 
The installation host must meet the added requirements of all 
installation components 

Installation Preparation 
! Action 

 You check the Windows file system [Page 54]. 

 You check the Windows domain structure [Page 54], if required. 

 You reduce the size of the file cache [Page 55]. 

 You grant user rights for the installation [Page 55]. 

 You choose the SAP system IDs [Page 59], if required. 

 You prepare the required CDs for the installation [Page 60]. 

Installation Process 
! Action 

 You install the MS SQL Server database server software [Page 63]. 

 
This action is not required if you install a system into an existing 
database (MCOD). 

 You run SAPinst [Page 66] and select J2EE only: SAP Web AS 6.30 for MS SQL Server 
(Central System) to install the central instance, the database instance, and the central 
services on one host. 

 
Make sure you start SAPinst from a newly created installation directory. 

 
If you install a system into an existing database (MCOD), see section 
Installation of Multiple Components in One Database ) [Page 32] for 
more information. 

 
Do not patch the SAP J2EE Engine or SDM during the deployment. Only 
apply patches after the whole installation procedure of the SAP J2EE 
Engine has been finished successfully. 

 You check the input for the installation [Page 69]. 

 

Post-Installation Activities 
! Action 

 Log off and log on again from your installation host. 

 As the SAP system is running after the installation, you check that you can stop and 
start the SAP system [Page 82]. 
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 You install the SAP license [Page 84]. 

 You install the SAP online documentation [Page 85]. 

 If you have copied installation CDs to your hard disk for an unattached installation, you 
can delete these files when the installation has successfully completed. 

 To distribute requests between multiple SAP Web AS instances you require a load 
balancing mechanism. For more information, see the SAP Service Marketplace at the 
Internet address service.sap.com/ti. 
One possibility is to use the SAP Web Dispatcher that gets delivered with the SAP 
system software. For more information about its use and its configuration, see the 
following in the SAP Library [Page 31]: J2EE Technology in SAP Web AS → 
Administration Manual → Server Infrastructure → Load Balancing Between Many 
J2EE Instances. 

 You check the SAP J2EE Engine documentation [Page 85]. 

 
Especially make sure that you check the mandatory post-installation 
procedures listed in the Administration Manual under Installation 
Information → Post-Installation Procedures. 

 You perform a full installation backup [Page 86]. 

 You change passwords of created users [Page 87]. 

 

3.1.3  Installation Checklist for a J2EE Dialog 
Instance for SAP Web AS - J2EE only 
Purpose 
You only use the following checklist when you want to install a J2EE dialog instance for an 
SAP Web AS J2EE system. 

 
Do not install J2EE dialog instances for an SAP Web AS ABAP+J2EE 
system. 

Process Flow 

Installation Planning 
! Action 

 You obtain the required documentation [Page 29]. 

 You check the hardware and software requirements [Page 43]. 

Installation Preparations 
! Action 

 You prepare the installation CDs [Page 60]. 

Installation Process 
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! Action 

 You run SAPinst [Page 66] and select J2EE only: SAP Web AS 6.30 J2EE Dialog 
Instance for MS SQL Server to install the J2EE dialog instance. 

 
Make sure you start SAPinst from a newly created installation 
directory. 

Post-Installation Activities  
! Action 

 You start and stop the SAP system [Page 82]. 

 If you have copied installation CDs to your hard disk for an unattached 
installation, you can delete these files when the installation has successfully 
completed. 

 You check the SAP J2EE Engine Documentation [Page 85]. 

 
Especially make sure that you check the mandatory post-
installation procedures listed in the Administration Manual under 
Installation Information → Post-Installation Procedures. 

 You perform a full installation backup [Page 86]. 

 You change passwords of created users [Page 87]. 

 

3.2  Installation Checklists for the SAP Web 
AS ABAP+J2EE System 

3.2.1  Installation Checklist for SAP Web AS - J2EE 
Add-In (Central System)  
You use the following checklist when you want to install SAP Web AS – J2EE Add-In on a 
single host. 

 
You must perform this installation on the central instance host of an already 
existing SAP Web AS 6.20 SP25. 

Prerequisites 
• You have planned the system configuration as described in Implementation 

Considerations [Page 10]. 

Process Flow 
Installation Planning 

! Action 

 An SAP system (ABAP) based on SAP Web AS 6.20 SP 25 or higher is a 
prerequisite for this installation. You can either use an existing SAP system based on 
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SAP Web AS 6.20 or install a new SAP system based on SAP Web AS 6.20 
according to the documentation Installation Guide – <SAP Component> on 
Windows: MS SQL Server  available in SAP Service Marketplace at: 
service.sap.com/instguides → <SAP Component>   → <Release> 

 
If your existing SAP Web AS 6.20 includes an SAP J2EE Engine 6.20, 
the installation option SAP Web AS – J2EE Add-In will delete this SAP 
J2EE Engine 6.20 before installing the SAP J2EE Engine 6.30. If you 
want to migrate an application created in the SAP J2EE Engine 6.20, 
make sure that you read the information in the Migration Manual in the 
SAP J2EE Engine documentation [Page 85] before the installation. 

You check that the SAP system based on SAP Web AS 6.20 fulfills the following 
prerequisites: 

• Support package [Page 31] 25 or higher is installed 

• The latest SAP Web AS 6.20 kernel is installed 

 If you installed a new SAP Web AS 6.20, make sure that you have performed the 
client copy [Page 31] to create a production client in your SAP system. 

This production client will be used for the communication user SAPJSF. 

 You obtain the required documentation [Page 29]. 

 You decide on the optimal configuration for your SAP system [Page 36]. 

 You check the hardware and software requirements [Page 43]. 

 
The installation host must meet the added requirements of all 
installation components. 

Installation Preparations 

! Action 

 Maintain your company address in your SAP system using transaction SU01. A 
maintained company address is mandatory for creating SAP system users. 

 You prepare the installation CDs [Page 60]. 

Installation Process 

! Action  

 You check, if you have installed an MS SQL server database with the new collation. 

If you run your MS SQL Server database with the old collation, you have the following 
options: 

• You perform a homogeneous system copy to convert your database to the new 
collation. For more information, see the documentation SAP Web AS 
Application Server 6.30 Homogeneous and Heterogeneous System copy which 
you can find in the SAP Service Marketplace [Page 30]. 

• You install the MS SQL Server database [Page 63] with the new collation [Page 
65]. In this case, we recommend to install a named instance [Page 35]. 
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 You run SAPinst [Page 66] and select J2EE Add-In: <Unicode> Finalize SAP Web AS 
6.30 for MS SQL Server (Central System) to install the J2EE engine, the database 
schema and the central services instance on the central instance host of the existing 
SAP system. 

 
Make sure you start SAPinst from a newly created installation 
directory. 

 
Do not patch the SAP J2EE Engine or SDM during the deployment. 
Only apply patches after the whole installation procedure of the SAP 
J2EE Engine has been finished successfully. 

 You check the input for the installation [Page 69]. 

Post-Installation Activities  

! Action 

 Log off and on again from your installation host. 

 As the SAP system is running after the installation, you check that you can stop 
and restart the SAP system [Page 82]. 

 You log on to the SAP system [Page 83]. 

 If you have copied installation CDs to your hard disk for an unattached 
installation, you can delete these files when the installation has successfully 
completed. 

 After the installation, the SAP J2EE Engine is activated. If you do not want to use 
the SAP J2EE Engine, you can deactivate it.  

For more information, see "Deactivation of the SAP J2EE Engine” in Additional 
Information about the SAP J2EE Engine [Page 93]. 

 To distribute requests between multiple SAP Web AS instances you require a 
load-balancing mechanism. For more information, see the SAP Service 
Marketplace at the Internet address service.sap.com/ti. 
One possibility is to use the SAP Web Dispatcher delivered with the SAP system 
software. For more information, see the following in the SAP Library [Page 31]: 
Client/Server Technology → Architecture of the SAP Web Application Server 
→SAP Web Dispatcher. 

 You check the SAP J2EE Engine documentation [Page 85]. 

 
Especially make sure that you check the mandatory post-
installation procedures listed in the Administration Manual under 
Installation Information → Post-Installation Procedures. 

 You perform a full installation backup [Page 86]. 

 You change passwords of created users [Page 87]. 

Additional Steps 

! Action 

 You can install one or more dialog instances [Page 26] if required. 
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3.2.2  Installation Checklist for SAP Web AS – J2EE 
Add-In (Distributed System) 
Purpose 
You use the following checklist when you want to install SAP Web AS – J2EE Add-In on 
multiple hosts. 

 
There is no installation service required to prepare the SAP Web AS central 
instance for SAP Web AS – J2EE Add-In. 

Prerequisites 
• You have planned the system configuration as described in Implementation 

Considerations [Page 10]. 

Process Flow 
... 

1. You perform the following steps to install the Central Services instance on the central 
services instance host: 

 
If you perform the following steps on the database instance host of the SAP 
Web AS - J2EE Add-In installation, ignore all steps shaded grey. 

Central Services Checklist 
a. Installation Planning 
! Action 

 An SAP system (ABAP) based on SAP Web AS 6.20 SP 25 or higher is a 
prerequisite for this installation. You can either use an existing SAP 
system based on SAP Web AS 6.20 or install a new SAP system based 
on SAP Web AS 6.20 according to the documentation Installation Guide – 
<SAP Component> on Windows: MS SQL Server  available in SAP 
Service Marketplace at the Internet address 

service.sap.com/instguides → <SAP Component>   → <Releas> 

 
If your existing SAP Web AS 6.20 includes an SAP J2EE 
Engine 6.20, the installation option SAP Web AS – J2EE 
Add-In will delete this SAP J2EE Engine 6.20 before 
installing the SAP J2EE Engine 6.30. If you want to migrate 
an application created in the SAP J2EE Engine 6.20, make 
sure that you read the information in the Migration Manual in 
the SAP J2EE Engine documentation [Page 85] before the 
installation. 

You check that the SAP system based on SAP Web AS 6.20 fulfills the 
following prerequisites: 

• Support package [Page 31] 25 or higher is installed. 

• The latest SAP Web AS 6.20 kernel is installed. 
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 You obtain the required documentation [Page 29]. 

 If you installed a new SAP system based on SAP Web AS 6.20, make 
sure that you have performed the client copy [Page 31] to create a 
production client in your SAP system. 

This production client will be used for the communication user SAPJSF. 

 You check the hardware and software requirements [Page 43]. 

b. Installation Preparations 
! Action 

 Maintain your company address in your SAP system using transaction 
SU01. A maintained company address is mandatory for creating SAP 
system users. 

 You prepare the installation CDs [Page 60]. 

c. Installation Process 
! Action 

 You run SAPinst [Page 66] and select J2EE Add-In: <Unicode> SAP Web 
AS 6.30 Central Services for MS SQL Server (Distributed System )to install 
the central services: 

 
Make sure you start SAPinst from a newly created 
installation directory. 

d. Post-Installation Steps 
! Action 

 If you have copied installation CDs to your hard disk for an unattached 
installation, you can delete these files when the installation has 
successfully completed. 

2. You perform the following steps to finalize the central instance installation on the 
central instance host of the already existing SAP Web AS 6.20: 

  
With this option you install the J2EE Engine and the database schema into 
the database. 

 
If you perform the following steps on the central services instance host of the 
SAP Web AS - J2EE Add-In installation, ignore all steps shaded grey. 
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Finalize the Central Instance Installation 
a. Installation Planning 
! Action 

 You check, if you have installed an MS SQL server database with the 
new collation. 

If you run your MS SQL Server database with the old collation, you have 
the following options: 

• You perform a homogeneous system copy to convert your database 
to the new collation. For more information, see the documentation 
SAP Web AS Application Server 6.30 Homogeneous and 
Heterogeneous System copy which you can find in the SAP Service 
Marketplace [Page 30]. 

• You install the MS SQL Server database [Page 63] with the new 
collation [Page 65]. In this case, we recommend to install a named 
instance [Page 35]. 

 You obtain the required documentation [Page 29]. 

 You check the hardware and software requirements [Page 43]. 

b. Installation Preparations 
! Action 

 You prepare the installation CDs [Page 60]. 

c. Installation Process 
! Action 

 You run SAPinst [Page 66] and select J2EE Add-In: <Unicode>Finalize 
Central Instance SAP Web AS 6.30 for MS SQL Server (Distributed 
System) to finalize the central instance installation. 

 
Make sure you start SAPinst from a newly created 
installation directory. 

 You check the input for the installation [Page 69]. 

d. Post-Installation Activities 
! Action 

 Log off and on again from your central instance host. 

 As the SAP system is running after the installation, you check that you can 
stop and restart the SAP system [Page 82] 

 You log on to the SAP system [Page 83] 

 If you have copied installation CDs to your hard disk for an unattached 
installation, you can delete these files when the installation has 
successfully completed. 
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 To distribute requests between multiple SAP Web AS instances you require 
a load-balancing mechanism. For more information, see the SAP Service 
Marketplace at the Internet address service.sap.com/ti. 
One possibility is to use the SAP Web Dispatcher delivered with the SAP 
system software. For more information, see the following in the SAP Library 
[Page 31]: 
Client/Server Technology → Architecture of the SAP Web Application 
Server → SAP Web Dispatcher. 

 After the installation, the SAP J2EE Engine is activated. If you do not want 
to use the SAP J2EE Engine, you can deactivate it.  

For more information, see "Deactivation of the SAP J2EE Engine” in 
Additional Information about the SAP J2EE Engine [Page 93]. 

 You check the SAP J2EE Engine documentation [Page 85]. 

 
Especially make sure that you check the mandatory post-
installation procedures listed in the Administration Manual 
under Installation Information → Post-Installation 
Procedures. 

 You perform a full installation backup [Page 86]. 

 You change passwords of created users [Page 87]. 

e. Additional Steps 
! Action 

 After the installation, you can install one or more dialog instances [Page 
26] if required. 

 

3.2.3  Installation Checklist for a Dialog Instance 
for SAP Web AS – J2EE Add-In 
Purpose 
You use the following checklist when you want to install the J2EE part of a dialog instance 
for an SAP Web AS ABAP+J2EE system. 

Prerequisites 
There is an already existing dialog instance (ABAP). If not, you have to install it as described 
in the documentation Installation Guide – <SAP Component> on Windows: MS SQL Server, 
section Installation Checklist for a Dialog Instance. 

Make sure that the SAP J2EE Engine installation for the corresponding SAP system is 
finished and that the SAP system is up and running. 
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Process Flow 

Installation Planning 
! Action 

 You obtain the required documentation [Page 29]. 

 You check the hardware and software requirements [Page 43]. 

Installation Preparation 
! Action 

 If you install the dialog instance on a separate host, you grant user rights for the 
installation [Page 55]. 

 You prepare the installation CDs [Page 60]. 

Installation Process 
! Action 

 You run SAPinst [Page 66] and select J2EE Add-In: <Unicode> Finalize Dialog 
Instance SAP Web AS 6.30 for MS SQL Server to finalize the dialog instance 
installation. 

 
Make sure you start SAPinst from a newly created installation 
directory. 

 You check the input for the installation [Page 69]. 

Post-Installation Activities  
! Action 

 You start and stop the SAP system [Page 82]. 

 You log on to the SAP system [Page 83]. 

 If you have copied installation CDs to your hard disk for an unattended installation, 
you can delete these files when the installation has successfully completed. 

 Make sure that the SAP system (including its SAP J2EE Engines) is up and 
running before dialog instances (with their SAP J2EE Engines) are started or 
restarted. 

 You check the SAP J2EE Engine documentation [Page 85]. 

 
Especially make sure that you check the mandatory post-installation 
procedures listed in the Administration Manual under Installation 
Information → Post-Installation Procedures. 

 You perform a full installation backup [Page 86]. 

 After the installation, the SAP J2EE Engine is activated. If you do not want to use 
the SAP J2EE Engine, you can deactivate it. See section Additional Information 
about the SAP J2EE Engine [Page 93] → Deactivation of the SAP J2EE Engine. 

 You change passwords of created users [Page 87]. 
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3.3  Additional Information 
You might need to refer to the optional sections below when installing your SAP system. 
! Action 

 Performing a Remote Installation with SAPinst [Page 89] 

 Continuing an Interrupted Installation with SAPinst [Page 91] 

 Additional Information about the SAP J2EE Engine [Page 93] 

 Deletion of an SAP System Installation [Page 97] 
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4  Installation Planning 
 

Make sure that you read the Installation Checklists [Page 16] before you start 
the installation planning. 

4.1  Required Documentation 
The following sections describe the documentation you require for the installation. 

• SAP Installation Notes 

• SAPinst Troubleshooting Guide 

• Information in the SAP Service Marketplace 

• Accessing the SAP Library 

4.1.1  SAP Installation Notes 
You must read the following SAP Notes before you start the installation. They contain the 
most recent information regarding the installation, as well as corrections to the installation 
documentation. 

Make sure that you have the up-to-date version of each SAP Note, which you can find in the 
SAP Service Marketplace at the Internet address: 

service.sap.com/notes 

Note Number Title 

658167 INST:SAP J2EE Engine f. SAP Systems based on Web AS 
6.30/WIN 

584524 INST: SAP Web AS 6.30 on Windows - General 

611361 Hostnames of SAP servers 

584539 INST: SAP Web AS 6.30 on Windows - MS SQL Server 

79991 Multi Language Support / Unicode 

45619 R/3 with several languages or typefaces 

42305 RSCPINST (NLS installation tool) 

 

4.1.2  SAPinst Troubleshooting Guide 
The SAPinst Troubleshooting Guide provides up-to-date information about how to avoid 
installation failure and what to do if a failure occurs.  

For more information, see the SAP Service Marketplace at the Internet address: 
service.sap.com/sapinstfeedback 
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We recommend that you read this documentation before starting the 
installation. 

4.1.3  Information in the SAP Service Marketplace 
Information on the following areas is available in the SAP Service Marketplace. 

 
Documents that are also delivered on the installation CDs are marked with 
"[<type> CD]". For example, "[Documentation CD]". 

 

Description Internet Address Title 

SAP Notes service.sap.com/notes – 

Released platforms service.sap.com/platforms – 

Installation of SAP 
NetWeaver Developer 
Workplace 

service.sap.com/instguides
→ SAP Web Application Server  
→ Release 6.30 

Installation Guide – SAP 
NetWeaver Developer 
Workplace. 

Installation of SAP 
NetWeaver Developer 
Studio 

service.sap.com/instguides
→ SAP Web Application Server  
→ Release 6.30 

Installation Guide – SAP 
NetWeaver Developer 
Studio 

Unicode SAP systems 
and their availability 

service.sap.com/unicode 

See also SAP Note 79991. 

– 

Technical infrastructure –
configuration scenarios 
and related aspects such 
as security, load 
balancing, availability, 
and caching 

service.sap.com/ti – 

Network infrastructure service.sap.com/network – 

System sizing  service.sap.com/sizing Quick Sizer tool 

Front-end installation  service.sap.com/instguides Front End Installation 
Guide  
[Presentation CD] 

High availability service.sap.com/ha – 

Homogeneous system 
copy 

service.sap.com/instguides
→ SAP Web Application Server → 
<release> 

Homogeneous and 
Heterogeneous System 
Copy for SAP Systems 
based on SAP Web 
Application Server 6.20 

Heterogeneous system 
copy 

service.sap.com/ 
osdbmigration 

Homogeneous and 
Heterogeneous System 
Copy for SAP Systems 
based on SAP Web 
Application Server 6.20 

Security service.sap.com/security – 
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4.1.4  Accessing the SAP Library 
For more information on the SAP Web Application Server, access the SAP Library from any 
of the following: 

• An SAP system if you have installed the online documentation: 
... 

a. Choose Help → SAP Library. 

The browser starts. 

b. In the browser, choose SAP NetWeaver Components → SAP Web Application 
Server. 

• The SAP Help Portal at the Internet address: 
help.sap.com 

... 

a. Choose SAP Web Application Server → SAP Web Application Server 6.30. 

b. Select the required language. 

c. Choose SAP NetWeaver Components  → SAP Web Application Server. 

• The help files on the online documentation CDs 

If you want to view the help files in HTML-Help format from the online documentation 
CDs, you need a PC running Microsoft Windows to install the HTMLHelp Viewer. 

4.2  Importing Support Packages 
Use 
You use this procedure to import Support Packages for your SAP system.  

Procedure 
... 

1. To import a Support Package, download the Support Packages from the SAP Service 
Marketplace at the Internet address: 
service.sap.com/patches 

2. Apply Support Packages to your SAP system with the help of the Support Package 
Manager (formerly called SAP Patch Manager, transaction SPAM). 

For more information on availability of Support Packages, see the SAP Service Marketplace 
at the Internet address: 
service.sap.com/ocs-schedules 

 
The SAP Note Assistant lets you load, implement, and organize individual 
SAP Notes efficiently. It also recognizes dependencies between SAP Notes, 
Support Packages, and modifications.  
For more information, see the SAP Service Marketplace at the Internet 
address: 
service.sap.com/noteassistant 

4.3  Performing the Client Copy 
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Use 
You use this procedure to perform the client copy, which consists of the following steps: 

• Maintain the client with transaction SCC4 

• Copy the client with local transaction SCCL 

• Copy the log files with transaction SCC3 

Procedure 
For more detailed information on how to perform the client copy, see the separate 
documentation in the SAP Library [Page 31]: 

Change and Transport System → Client Copy and Transport 

4.4  Database Installation for Multiple 
Components 
Each SAP system in your mySAP environment needs its own database back end. With MS 
SQL Server you have the following options to distribute your systems across the available 
hardware resources. They differ with respect to hardware requirements, database 
administration, flexibility, and scalability. 

• Exclusive database server 

In this system landscape, each database server (with or without a central instance) 
hosts exactly one SAP database. From an installation planning perspective, this is 
the simplest solution. It is the most scalable setup, but it requires the most hardware. 
This option is typically chosen for medium-sized and large production and 
development systems. 

• Named SQL Server instances 

With the use of named instances, you can install multiple, independent SQL Server 
instances on a single database server. These instances share CPU, memory and 
disk resources, but from an administration point of view are completely independent 
from each other. This option, like the following two, requires careful hardware sizing 
to avoid performance bottlenecks and scalability problems. 

• Multiple databases in a default SQL Server instance 

SQL Server lets you operate multiple user databases in a single SQL Server 
instance. Contrary to named instances, the databases share the temporary system 
database tempdb, the SQL Server Windows process, and the SQL Server memory 
pool. Therefore, this setup is less scalable than named instances, but at the same 
time requires less system resources. It can be a flexible solution for small and 
medium-sized systems. 

• Multiple Components in One Database (MCOD) 

Multiple database back ends are stored in the same database, each in its own 
database schema. For the database administrator, the database containing these 
multiple components looks very much like a single entity. While this approach is not 
as flexible as the other options, its simplicity makes it an attractive solution for small 
mySAP environments. 

In the following two chapters we discuss MCOD and named instances in more detail. The 
section on named instances briefly describes multiple databases in a single instance. 
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4.4.1  Installation of Multiple Components in One 
Database 
Use 
You can install multiple SAP systems in a single database. This is called Multiple 
Components on One Database (MCOD). 

MCOD is scheduled to be available with all mySAP.com components. We are releasing this 
technology on all the major databases for the SAP system, in line with our commitment to 
deliver platform-independent solutions. 

Using this technology is as easy as installing a separate component. No extra effort is 
required because the MCOD installation is fully integrated into the standard installation 
procedure. MCOD is not an additional installation service. Instead, it is an option of the 
database instance installation. 

Prerequisites 
• For more information on MCOD and its availability on different platforms, see the SAP 

Service Marketplace at the Internet address: 
service.sap.com/mcod 

• Improved sizing required. 

In general, you calculate the CPU usage for an MCOD database by adding up the CPU 
usage for each individual SAP system. The same applies to memory resources and 
disk space. 

You can size multiple components on one database by sizing each individual 
component using the SAP Quick Sizer and then adding the requirements together. For 
more information on the SAP Quick Sizer, see the SAP Service Marketplace at the 
Internet address: 
service.sap.com/quicksizer 

Features 
• Reduced effort for database backup and restore. 

• Consistent system landscape for backup, system copy, administration, and recovery. 

• Increased security and reduced database failure for multiple SAP systems due to 
monitoring and administration of only one database. 

• In an MCOD landscape you can upgrade a single component independently from the 
other components running in the same database, assuming that the upgraded 
component runs on the same database version. However, if you need to restore a 
backup, be aware that all other components are also affected. 

• Special MCOD considerations and differences from the standard procedure are listed 
where relevant in the installation documentation. 

Constraints 
• We strongly recommend that you test MCOD in a test or development system. We 

recommend that you run MCOD systems in the same context and do not mix test, 
development, and production in the same MCOD environment. In the event of 
database failure, all SAP systems running on the single database are affected. 
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• Copying a single component from an MCOD landscape to another database at 
database level is not possible. 

• De-installing a single component from an MCOD landscape requires some additional 
steps. You can use SAPNet -- R/3 Frontend to request help with these tasks. 

• You cannot install multiple components on one database in a cluster. 

Activities 
With MCOD we distinguish two scenarios: 

• The installation of an SAP system in a new database 

• The installation of an additional SAP system in an existing database 

 
All differences in the installation procedure for MCOD are marked in the 
corresponding sections of this documentation. 

Installing the First SAP System into a New Database 
... 

1. Perform the central instance installation as usual. 

 
You install the central instance with SAP system ID C11. 

2. Start the database instance installation. 

3. When you are prompted for Database Installation Type, choose Install (first) 
SAPsystem into a new database 

 
You install the database instance C11. On some platforms, you can choose a 
database instance ID that is different from the SAP system ID, for example 
D11. 

4. Finish the installation. 

Installing an additional SAP System into an Existing Database 
... 

1. Perform the central instance installation as usual. 

 
You install the central instance with SAP system ID C12. 

2. Start the database instance installation. 

3. When you are prompted for Database Instance Type, choose Install (additional) SAP 
system into an existing database. 

4. When SAPinst prompts you for the Name of the database instance, enter exactly the 
database instance <DBSID> of the existing database. 

 
When SAPinst prompts for the database instance name, enter C11. 

5. Finish the installation. 

Due to the MCOD installation, some installation steps are not required and therefore do not 
appear. These steps are marked in section "Input for the Installation”. 
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4.4.2  Default or Named MS SQL Server Instances 
When you install MS SQL Server 2000, you can install two different types of instances: 

• Default 

• Named 

When you plan your system configuration, you must decide which instance type you want to 
install. The following clarifies the difference between the two.  

Default Instance 

A default instance is the most common form of an MS SQL Server 2000 installation in an 
SAP environment. Typically, one MS SQL Server instance is installed together with a single 
SAP database. In this configuration, all MS SQL Server components and functionality are 
exclusively available for the SAP database.  

In a less frequently implemented configuration, a single MS SQL Server instance is installed 
together with more than one SAP database on the same computer. In this type of 
configuration, the MS SQL Server components such as executables, system databases and 
utilities exist only once and have to be shared by all SAP databases. As all the databases 
on the computer have to be managed with a single copy of the MS SQL Server, certain 
administrative tasks on one database cannot be performed in isolation without affecting the 
other databases.  

 
A default instance is recommended, if you plan to install only one SAP 
database instance on a computer.  

Named Instance 
A named instance installation allows the installation of multiple, separate MS SQL Server 
instances with corresponding SAP databases on the same computer. Multiple named 
instances can coexist on the same computer and function in isolation of each other. During 
the installation, each one is given a name that is the same as the SAP system name, thus 
enabling a unique assignment of instances to SAP databases.  

The advantage of named instances is that you can set up several SAP databases on the 
same machine and administer each one separately with its own copy of the MS SQL Server. 
The main components of the MS SQL Server are available exclusively for each database and 
can be used only by that database. Only a few resources such as client utilities have to be 
shared by all the databases because they are only installed once.  

 
A named instance is recommended, if you plan to install more than one SAP 
database instance on the same machine.  

The following graphic illustrates a computer where two MS SQL Server named instances 
have been installed for two SAP databases, <SAPSID1> and <SAPSID2>.  



4   Installation Planning   

4.5   System Configuration 

36 October 2003 

P45616\<SAPSID1>

Databases

<SAPSID1>

Data Transformation Service

master

model

msdb

. . . . .

Management
. . . . .
. . . . .

P45616\<SAPSID2>

Databases

<SAPSID2>

Data Transformation Service

master

model

msdb

. . . . .

Management
. . . . .

. . . . .
 

 

4.5  System Configuration 
• You and your hardware partner generally plan the system configuration before the 

installation.  

• You and your hardware partner work out a high-performance configuration based on 
sizing information that reflects the system workload, such as: 

{ The set of applications to be deployed 

{ How intensively the applications are to be used 

{ The number of users 

• You decide whether you want to perform a domain or local installation 

The installation types differ as follows: 

{ Local installation 

You need to be Local Administrator of the machine involved. In a local 
installation, all Windows account and user information is stored locally on one 
host and is not visible to any other hosts in the system.  

If the SAP system is to run on a single machine, you can perform a local 
installation. 

 
Performing a local installation for a distributed system leads to authorization 
problems that have to be resolved. 

{ Domain installation 

You need to be Domain Administrator of the domain involved, and all 
machines in the system must belong to the same domain. In a domain 
installation, the user information is stored centrally on the domain controller and 
is accessible to all hosts in the system.  
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If the system is to be distributed across more than one machine, we strongly 
recommend a domain installation.  

 
If for any reason, you are not granted domain administration rights, you can 
perform the installation as a domain user who is a member of the local 
administrator group. However, the domain administrator has to prepare the 
system appropriately for you. For more information, see Performing a Domain 
Installation Without Being a Domain Administrator [Page 56]. 

See also: 

Granting User Rights for the Installation [Page 55] 

4.5.1  Distribution of Components to Disks 
When you install the SAP system with an MS SQL Server database, the main directories 
required for the system are automatically created. The following graphic gives you an 
overview of the main SAP system components and directories, their purpose, and the amount 
of free space they initially require. A good distribution of these to disks ensures that: 

• Enough free space is available for system growth 

• The data is secure 

• Performance is good 
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Database Components 
When you install an SAP system with MS SQL Sever, the central components of the 
database are the SQL Server program files, tempdb files, SAP data files and transaction 
log files. The log files record all the changes made to the database to enable restore and 
recovery. The tempdb holds all temporary tables and stored procedures. The data files 
contain the data for the SAP system. 

• SAP Data Files 

The data files are created by default in the directories \<SAPSID>DATA<N>. The first 
data file is called <SAPSID>DATA1.mdf and subsequent 
files<SAPSID>DATA<N>.ndf, where <N> denotes the number of the file. You can 
change the default value of these directories. The minimum space required for all files 
is 20 GB. 

For security reasons, locate the data files on a separate disk system. They should not 
be included in the same disk system as the log files or other SQL server program and 
database files. To ensure data redundancy, SAP recommends the use of RAID 5. 

• Transaction Log File 
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The transaction log for the database is created by default in the directory 
\<SAPSID>LOG1. The log file is called <SAPSID>LOG1.ldf and requires a 
minimum of 1 GB space. You can change the default directory of the transaction log 
directory. 

The transaction log file records all the changes made to the database and, if required, 
enables modifications to be redone or undone. It plays a crucial role when the 
database has to be restored due to database damage or media failure. For this reason 
it should be stored very securely. SAP recommends the use of RAID 1 which 
implements hardware-based mirroring.  

• Program Files 

The files other than the SAP data and transaction log files are created in the 
subdirectories of \Program Files\Microsoft SQL Server. These include the 
SQL Server program files and the master, msdb and tempdb database files. Locate 
these on a separate, third, disk system and not on the same disks as the transaction 
log files or SAP data files. SAP recommends the use of RAID 1. 

For performance reasons, it is advisable to place the tempdb files on a fast disk 
system. This is particularly recommended because the tempdb is frequently accessed 
during SQL Server operation and could otherwise affect performance.  

 
After the initial installation of the database software, the tempdb is located in 
a subdirectory of \Program Files\Microsoft SQL Server. However 
later, when SAPinst builds and loads the database, it is transferred to a new 
\TEMPDB directory and extended to a size of 300 MB. 

4.5.2  Standard Configuration 
The following graphic illustrates how the main directories that are created during the 
installation can be distributed to RAID arrays. The distribution is suitable for an average-sized 
production system. Keep in mind that this is only an example and that no single solution is 
fitting for all environments. 

 
The SAP kernel files and the transport directory can be assigned to any of the 
arrays depicted, but must both be located on the same array. The transport 
directory does not necessarily have to reside on the central instance host. 
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Distribution of Directories to Arrays 

Array 1 \Program files\Microsoft SQL Server 
\TEMPDB 

Array 2 \<SAPSID>DATA1 
\<SAPSID>DATA2 
\<SAPSID>DATA3 

Array 3 \<SAPSID>log1 

 

Optimizing Performance 
If you wish to optimize performance, isolate the tempdb on a separate, fast disk. This 
improves performance significantly because the tempdb is continually accessed during MS 
SQL Server operation.  

A further option for improving performance is to place the Windows paging file on a separate, 
fast disk.  

4.5.3  SAP Directories 
Definition 
The following SAP directory is created during the J2EE Add-In installation: 

• \usr\sap\<sapsid>\<instance_abap>\j2ee 

This directory is global, that is, it is accessed by all of the hosts in the SAP system. 
Therefore, it has a name that follow the Universal Naming Convention (UNC). 

We distinguish between a global, local, and database host: 

• Global host 

Machine on which the central instance is running 

• Local host 

Current machine on which an SAP instance is running 
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• DB host 

Machine on which the database server is running 

Use 

\usr\sap 
The SAP software is stored in the \usr\sap directory: 

• On global hosts, the \usr\sap directory contains global and local (instance-specific) 
data. 

• On local hosts, \usr\sap contains only instance-specific data and copies of the SAP 
executables. The executables on the local host are replicated from those on the global 
host each time the local instance is started. 

The installation program creates the \usr\sap directory on the global host and shares it with 
the names sapmnt and saploc. The same directory on the local host is shared as saploc. 

 
Since SAP traces for the instance are created in \usr\sap, make sure there 
is sufficient space available in this directory. Changes in SAP profiles can also 
affect the disk space.  
If you create the subdirectory ......\SYS (global data) locally on application or 
front-end servers, you have to distribute the software for the SAP system 
manually when upgrading to a new SAP release. SAP does not support this. 

Structure 
The following graphics show how the physical directory \usr\sap is shared on the global 
host and in a distributed installation. In both cases, UNC names are used as follows: 

• \\<SAPGLOBALHOST>\sapmnt to access global directories 

• \\<SAPLOCALHOST>\saploc to access local instance-specific data 
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The above graphic shows the directory structure on the global host. The global data is stored 
in the global directories on the global host and physically exists only once for each SAP 
system.  

Other computers access the data using the UNC name, \\<SAPGLOBALHOST>\sapmnt, 
where SAPGLOBALHOST is replaced by the SAP system with the name of the global host. The 
global host accesses its own instance-specific data using the UNC name 
\\<SAPLOCALHOST>\saploc. On the global host, the parameters SAPGLOBALHOST and 
SAPLOCALHOST have the same value. 
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The above graphic shows how the central instance, which runs on the global host, interacts 
with a distributed instance running on another computer. On a distributed instance host, the 
parameters SAPGLOBALHOST and SAPLOCALHOST have different values. Distributed 
instances use SAPGLOBALHOST to access global data on a separate host, that is, the global 
host with the central instance. 

4.6  Hardware and Software Requirements 
Purpose 
You check the hardware and software requirements using the requirement checklists in the 
following sections. They give the minimum requirements for small SAP system installations 
and do not include customer data. Depending on the amount of data involved, the 
requirements might change. For a more precise sizing definition that reflects your particular 
system load: 

• Use the SAP Quick Sizer tool that is available in the SAP Service Marketplace. You 
enter information on your planned system and the tool calculates the requirements. For 
more information, see the SAP Service Marketplace at the Internet address: 
service.sap.com/sizing  

• Contact a hardware vendor. The vendor can analyze the load and calculate suitable 
hardware sizing for you. 

• Contact the person in charge of installation, or your Competence Center, or your 
Microsoft representative. 
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Prerequisites 
• Use Windows 2000 or Windows Server 2003 as the operating system 

 
With Windows 2000 or Windows Server 2003, you must use the English 
(International) version of the operating system, but you can use a different 
language for the graphical user interface (GUI). For more information, see 
SAP Note 362379. 
You specify the operating system language when you install the operating 
system 

• For remote support, the remote connection specified in the contract agreement must be 
available before installation. The Internet address setup at SAP and registration are 
dealt with during the installation. 

• You are only allowed to install an SAP system on certified hardware. AddOn 
Technology Center for SAP (AddOn TCS) certifies hardware platforms for SAP on 
specified releases of Microsoft Windows 2000 or Windows Server 2003. You can then 
run the SAP system on the respective platform for all the combinations of the SAP 
system and databases released by SAP for the specified Windows release. You can 
find more information about certified platforms at the Internet address: 
saponwin.com 

• For more information on the released operating systems, see SAP Note 407328. 

Process Flow 
... 

1. For a central system and standalone database system, see the following checklists: 

{ Central instance [Page 44] 

{ Database instance [Page 47] 

{ SAP Central Services instance 

{ Dialog instance [Page 51], if you want to install additional (J2EE) dialog 
instances 

 
If you install multiple SAP system instances on one host, you need to add up 
the requirements.  

2. You check the network requirements. For more information, see the documentation 
Network Integration of SAP Servers in the SAP Service Marketplace at the Internet 
address: 

service.sap.com/network Æ Network Integration Guides 

For more information on SAP software in PC networks, see SAP Note 5324. 

 
If you do not fully meet the relevant requirements, you might experience 
problems when working with the SAP system. 
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4.6.1  Requirements Checklist for the Central 
Instance 
The central instance host must meet the following requirements: 

Requirement Type Requirement 

Hardware • Suitable backup system 

• Minimum disk space 

{ J2EE Engine database: 850 MB 

{ for a central system installation 
(J2EE Engine, central instance and 
database instance, central services 
instance are installed on one host): 

non-Unicode: 

12 GB (not including virtual 
memory) on at least 3 physically 
separate disks 

Unicode:  

20 GB (not including virtual 
memory) on at least 3 physically 
separate disks 

{ 650 MB of temporary disk space for 
every required required installation 
CD [Page 60] that you have to copy 
to a local hard disk 

To check disk space: 
... 

a. Choose Start → Programs → 
Administrative Tools → Computer 
Management → Disk Management. 

b. Right-click the local drive and 
choose Properties. 

• Minimum RAM: 

{ Central instance of a SAP Web AS 
J2EE system: 

� 512 MB 

{ Central instance of a SAP Web AS 
ABAP+J2EE system: 

� Non-Unicode SAP system: 
768 MB 

� Unicode SAP system: 1.2 GB 

{ SAP J2EE Engine:  

Between 64 MB and 4096 MB, 
depending on the load of your SAP 
system. 
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Requirement Type Requirement 

 
Do not enter a value larger than the 
maximum Java heap size of your 
platform. For more information, see 
the documentation for your Java 
Development Kit (JDK). 

To check RAM, in the Windows Explorer 
choose Help → About Windows. 

• Paging File Size (also known as virtual 
memory): 1 GB plus 3 times RAM.  
Maximum required is 10 GB. 

To check paging file size: 

 
... 

a. Right-click My Computer and 
choose Properties. 

b. Choose Advanced → Performance 
Options. 

c. If required, in section Virtual 
Memory, choose Change. 

Software  { MS SQL Server 2000 Enterprise 
Edition (server software) 

{ Service Pack 3 for MS SQL Server 

 
For more information on the 
current Service Pack for MS SQL 
Server, read SAP Notes 62988 
and 529150. 

{ The new collation for MS SQL 
Server [Page 65] 

• English international version of one of the 
following: 

{ Windows Server 2003 Enterprise 
Edition (32 bit) 

{ Windows Server 2003 Datacenter 
Edition (32 bit) 

{ Windows 2000 Advanced Server 

{ Windows 2000 Data Center Server 

 
Note the following: 
For any version of Windows 2000, 
you need service pack 3. For 
more information on the latest 
service pack supported by SAP, 
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Requirement Type Requirement 
see SAP Note 30478. 

To check your Windows version: 
... 

a. Choose Start  → Programs 
→ Accessories → Command 
Prompt 

b. Enter the command winver 

• Suitable Windows Resource Kit is strongly 
recommended 

Other  • Make sure that the host name fulfills the 
requirements listed in SAP Note 611361. 
For example, the host name must not be 
longer than 13 characters. 

• If you want to install a printer on a 
decentralized host for the SAP system, 
make sure that the printer can be accessed 
under Windows. 

• Check that the requirements of network, 
dialog instance, and operating system are 
met. 

 

4.6.2   Requirements Checklist for the Database 
Instance 
The database instance host must meet the following requirements: 

Requirement Type Requirement 

Hardware  • Suitable backup system 

• Minimum disk space 

{ non-Unicode: 

9 GB (not including virtual 
memory) on at least 3 physically 
separate disks  

{ Unicode: 

14 GB (not including virtual 
memory) on at least 3 physically 
separate disks  

{ 650 MB of temporary disk 
space for every required 
installation CD [Page 60] that 
you have to copy to a local hard 
disk. 

To check disk space: 
... 
... 

a. Choose Start → Programs → 
Administrative Tools → 
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Computer Management → Disk 
Management. 

b. Right-click the local drive and 
choose Properties. 

• Minimum RAM: 

{ non-Unicode SAP system: 
512 MB 

{ Unicode SAP system: 
1 GB 

To check RAM, in the Windows 
Explorer choose Help → About 
Windows 

• Paging file size (also known as virtual 
memory) of 1.5 times RAM 
(recommended by Microsoft) 
To check: 

... 

a. Right-click My Computer and 
choose Properties. 

b. Choose Advanced → 
Performance Options. 

c. If required, in section Virtual 
Memory, choose Change. 

Software • MS SQL Server 2000 Enterprise 
Edition: Server Software 

• Service Pack 3 for MS SQL Server 

 
For more information on the 
current Service Pack, read 
SAP Note 62988 and 
529150. 

• The new collation for MS SQL Server 
[Page 65] 

• English international version of one of 
the following: 

{ Windows Server 2003 
Enterprise Edition (32 bit) 

{ Windows Server 2003 
Datacenter Edition (32 bit) 

{ Windows 2000 Advanced 
Server 

{ Windows 2000 Data Center 
Server 

 
For any version of Windows 
2000, you need service pack 
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3. For more information on 
the latest service pack 
supported by SAP, see SAP 
Note 30478. 

To check your Windows version: 
... 

a. Choose Start → Programs → 
Accessories → Command 
Prompt. 

b. Enter the command winver 

• Suitable Windows Resource Kit is 
strongly recommended. 

Other  • Make sure that the host name fulfills 
the requirements listed in SAP Note 
611361. For example, the host name 
must not be longer than 13 characters. 

• If you want to install a printer on a 
decentralized host for the SAP system, 
make sure that the printer can be 
accessed under Windows. 

• Check that the network, dialog 
instance, and operating system 
requirements are met 
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4.6.3  Requirements Checklist for SAP Central 
Services Instance 
The SAP Central Services instance host must meet the following requirements: 

Requirement Type Requirement 

Hardware  • Suitable backup system 

• Minimum disk space 

{ Central services instance: 2 GB 
(not including virtual memory) 

{ 650 MB of temporary disk 
space for every required 
installation CD [Page 60] that 
you have to copy to a local hard 
disk). 

To check disk space: 
... 

a. Choose Start → Programs → 
Administrative Tools → 
Computer Management → Disk 
Management. 

b. Right-click the local drive and 
choose Properties. 

• Minimum RAM: 

{ Non-Unicode SAP system: 512 
MB 

{ Unicode SAP system: 1 GB 

{ SAP J2EE Engine: between 64 
MB and 512 MB, depending on 
the load of your SAP system. 

 
Do not enter a value larger 
than the maximum Java heap 
size of your platform. For 
more information, see the 
documentation for your Java 
Development Kit (JDK). 

c. To check RAM, in the Windows 
Explorer choose Help → About 
Windows. 

Software  • English international version of one of 
the following: 

{ Windows Server 2003 
Enterprise Edition (32 bit) 

{ Windows Server 2003 
Datacenter Edition (32 bit) 
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{ Windows 2000 Advanced 
Server 

{ Windows 2000 Data Center 
Server 

 
Note the following:  
For any version of Windows 
2000, you need service pack 
3. For more information on 
the latest service pack 
supported by SAP, see SAP 
Note 30478. 

To check the Windows version: 
... 

a. Choose Start → Programs → 
Accessories → Command 
Prompt. 

b. Enter the command winver 

• Suitable Windows Resource Kit is 
strongly recommended 

Other  • Make sure that the host name fulfills 
the requirements listed in SAP Note 
611361. For example, the host name 
must not be longer than 13 characters. 

• If you want to install a printer on a 
decentralized host for the SAP system, 
make sure that the printer can be 
accessed under Windows. 

• Check that the network, dialog 
instance, and operating system 
requirements are met. 

 

4.6.4  Requirements Checklist for a (J2EE) Dialog 
Instance 
The (J2EE) dialog instance host must meet the following requirements: 

Requirement Type Requirement 

Hardware  • Minimum disk space 

{ Dialog instance: 4 GB (not 
including virtual memory) 

{ 650 MB of temporary disk 
space for every required 
installation CD [Page 60] that 
you have to copy to a local hard 
disk). 

To check disk space: 
... 
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a. Choose Start → Programs → 
Administrative Tools → 
Computer Management → Disk 
Management. 

b. Right-click the local drive and 
choose Properties. 

• Minimum RAM: 

{ Dialog instance for an SAP Web 
AS J2EE system: 

� 256 MB 

{ Dialog instance for an SAP Web 
AS ABAP+J2EE system: 

� Non-Unicode SAP 
system: 512 MB 

� Unicode SAP system:  
1 GB 

{ SAP J2EE Engine: between 64 
MB and 512 MB, depending on 
the load of your SAP system. 

 
Make sure you do not enter a 
value larger than the 
maximum Java heap size of 
your platform. For more 
information, see the 
documentation for your Java 
Development Kit (JDK). 

To check RAM, in the Windows 
Explorer choose Help → About 
Windows. 

• Paging File Size (also known as virtual 
memory): 1 GB plus 3 times RAM. 
Maximum required is 10 GB. 

To check paging file size: 
... 

a. Right-click My Computer and 
choose Properties. 

b. Choose Advanced → 
Performance Options. 

c. If required, in section Virtual 
Memory, choose Change. 

Software  • MS SQL Server 2000 Enterprise 
Edition: Client Tools Only software 

• Service Pack 3 for MS SQL Server 

 
For more information on the 
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current Service Pack for MS 
SQL Server, read SAP Notes 
62988 and 529150. 

• English international version of one of 
the following: 

{ Windows Server 2003 
Enterprise Edition (32 bit) 

{ Windows Server 2003 
Datacenter Edition (32 bit) 

{ Windows 2000 Advanced 
Server 

{ Windows 2000 Data Center 
Server 

 
Note the following:  
For any version of Windows 
2000, you need service pack 
3. For more information on 
the latest service pack 
supported by SAP, see SAP 
Note 30478. 

To check the Windows version: 

a. Choose Start → Programs → 
Accessories → Command 
Prompt. 

b. Enter the command winver 

• Suitable Windows Resource Kit is 
strongly recommended 

Other  • Make sure that the host name fulfills 
the requirements listed in SAP Note 
611361. For example, the host name 
must not be longer than 13 characters. 

• If you want to install a printer on a 
decentralized host for the SAP system, 
make sure that the printer can be 
accessed under Windows. 

• Check that the network, dialog 
instance, and operating system 
requirements are met. 
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5  Installation Preparations 
 

Make sure that you read the Installation Checklists [Page 16] before you start 
the installation preparations. 

5.1  Checking for the Windows File System 
Use 
You need to check that you are using the Windows File System (NTFS) on hosts where you 
want to install the SAP system and database. NTFS supports full Windows security and long 
file names. 

 
You must use NTFS for an SAP system installation.  
Do not install the SAP directories on an FAT partition. 

Procedure 
... 

1. Open the Windows Explorer. 

2. Select the root directory. 

3. Choose File → Properties → General. 

The system displays the type of file system in use. 

4. Check that the file system is NTFS. 

5.2  Checking the Windows Domain Structure 
Use 
In Windows, you can implement either of the following domain models for the SAP system: 

• Extra domain 

In this model, the SAP system is embedded in its own domain, which is specially 
defined for SAP. A second domain exists for the user accounts. 

In Windows, the SAP domain and user domain must be incorporated in a domain tree. 
In this tree, the user accounts must form the root domain and the SAP domain must be 
a child domain of this. 

• Single domain 

In this model, the SAP system and the user accounts are included in a single domain. 

Prerequisites 
• You are performing a domain installation. 

• You are familiar with checking Windows domain structures. For more information, see 
the Windows documentation. 
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For performance and security reasons, make sure that you do not run an SAP 
instance (including the database instance) on the host where the domain 
controller is running.  

Procedure 
For a domain installation, we recommend that you check that all SAP system and database 
hosts are members of a single Windows domain. We recommend this for all SAP system 
setups.  

 
You do not need this step for a local installation. 

5.3  Reducing the Size of the File Cache 
Use 
You use this procedure to reduce the size of the file cache. 

Procedure 
... 

1. Choose Start → Settings → Control Panel → Network and Dial-up Connections. 

2. In the Network and Dial-up connections dialog box, double-click Local Area 
Connections. 

3. In the Local Area Connection Status dialog box, choose Properties. 

4. In the Local Area Connection Properties dialog box, double-click File and Printer 
Sharing for Microsoft Networks. 

 
If you cannot select File and Printer Sharing for Microsoft Networks, this 
option has not yet been installed. To install it, you need the Windows Server 
CDs. 

5. Select Maximize data throughput for network applications. 

6. To confirm your entries, choose OK. 

5.4  Granting User Rights for the Installation 
Use 
You need to make sure that you have the required rights and privileges that authorize you to 
install the SAPinst tool and the SAP system. 

 
If you attempt the installation without the required authorization, the system 
aborts.  

If necessary, you have to ask the system administrator to grant you the necessary 
authorization before you start the installation. 

Prerequisites 
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• The authorization required depends on whether you intend to perform a domain or local 
installation. For more information, see the sections Installation Planning and System 
Configuration. 

• A domain installation requires a domain controller to store user and account 
information centrally for the whole system. 

  
For performance and security reasons, make sure that you do not run an SAP 
instance (including the database instance) on the host where the domain 
controller is running.  
Never perform a local installation on a domain controller. 

Procedure 

Local Installation  
... 

1. Check that you have Local Administration rights for the central instance host. 

In a local installation, all Windows account and user information is stored locally on one 
host and is not visible to any other hosts in the system. 

2. If required, obtain these rights by asking the system administrator to enter you as a 
member of the Local Admins group. 

Domain Installation 
... 

1. Check that you have Domain Administration rights. 

In a domain installation, the user information is stored centrally on the domain 
controller and is accessible to all hosts in the system. 

2. If required, obtain these rights by asking the system administrator to enter you as a 
member of the Domain Admins group. 

 
If you are not granted domain administration rights, you can perform the 
installation as a domain user who is a member of the local administrator 
group. However, the domain administrator has to prepare the system 
appropriately for you.  
For more information, see Performing a Domain Installation without being a 
Domain Administrator [Page 56]. 

5.4.1  Performing a Domain Installation Without 
Being a Domain Administrator 
Use 
If you are not granted domain administrator rights, you can perform the installation as a 
domain user who is a member of the local administrator group. In this case, the domain 
administrator must prepare the system for you appropriately, as described in this section. 

 
You normally perform a domain installation of the SAP system as a user with 
domain administration rights, as described in Granting User Rights for the 
Installation [Page 55].  

The domain administrator has to: 
... 
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1. Create the new global group SAP_<SAPSID>_GlobalAdmin. 

2. Create the two new SAP system users <sapsid>adm and SAPService<SAPSID> 
(this user is not created for Informix installations). 

3. Add the users <sapsid>adm and SAPService<SAPSID> to the newly created group 
SAP_<SAPSID>_GlobalAdmin. 

Prerequisites 
You must perform this procedure as a domain administrator.  

Procedure 

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin 
... 

1. Log on as domain administrator. 

2. To start the Active Directory Users and Computers Console, choose: 

Start → Programs → Administrative Tools → Active Directory Users and Computers  

 
If you cannot find Active Directory Users and Computers, start it as follows: 

a. Choose Start → Run and enter mmc. 

b. Choose Console → Add/Remove Snap-in... → Add. 

c. Select Active Directory Users and Computers. 

d. Choose Add. 

e. Choose Close → OK. 

3. Right-click Users in Tree, and choose: 

New → Group 

4. Enter the following: 

Group name: SAP_<SAPSID>_GlobalAdmin 

 
Enter the SAP_<SAPSID>_GlobalAdmin group exactly as specified in the 
correct uppercase and lowercase. 

5. Select the following: 

a. Group scope:  Global 

b. Group type:  Security 

6. Choose OK. 

Creating the New SAP System Users <sapsid>adm and 
SAPService<SAPSID> 
... 

1. In Active Directory Users and Computers Console, right-click Users in Tree and 
choose: 

New → User 

2. Enter the following: 
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Enter the <sapsid>adm and SAPService<SAPSID> user exactly as 
specified in the correct uppercase and lowercase. 

Field Input for  
<sapsid>adm 

Input for 
SAPService<SAPSID> 

First name: None None 

Initials: None None 

Last name: None None 

Full name: <sapsid>adm SAPService<SAPSID> 

User logon name: <sapsid>adm SAPService<SAPSID> 

User logon name  
(before Windows 2000): 

<sapsid>adm SAPService<SAPSID> 

3. Choose Next and enter the following: 

Password: <password> 

Confirm password: <password> 

4. Select Password never expires 

 
Make sure that no other options are selected. 

5. Choose Next → Finish. 

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin 
Group 
... 

1. In the Users folder, double-click the newly created user account in the list on the right. 

2. Choose Member → Add. 

3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the 
list. 

 
By default, the user is also a member of the Domain Users group. 

4. Choose OK twice. 

Adding the SAPService<SAPSID> User to the 
SAP_<SAPSID>_GlobalAdmin Group 
... 

1. In the Users folder, double-click the newly created user account SAPService<SAPSID> 
in the list on the right. 

2. Choose Member → Add. 

3. Select the new SAP_<SAPSID>_GlobalAdmin group. 

4. Choose Add to add it to the list. 

5. Choose OK. 
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The SAPService<SAPSID> user must not be a member of the domain users 
group.  
To remove this group from the Member of list: 

a. Select the SAP_<SAPSID>_GlobalAdmin group. 

b. Choose Set Primary Group. 

c. Select the domain users group. 

d. Choose Remove to delete it from the Member of list. 

6. Choose OK to close SAPService<SAPSID> Properties. 

7. Close the Active Directory Users and Computers Management Console. 

5.5  Choosing the SAP System ID and Host 
Name 
Use 
You need to choose an SAP system ID that identifies the whole system. This ID has to be 
entered for the variable <SAPSID> when you install the central instance. You also need to 
check the host name for compatibility. 

 
You cannot change the SAP system ID after the installation. 

Procedure 
... 

1. Make sure that you system IDs : 

a. Are unique throughout your organization 

b. Consist of exactly three alphanumeric characters 

c. Contain only uppercase letters 

d. Have a letter for the first character 

e. Do not include any of the following, which are reserved IDs: 
ADD ALL AND ANY ASC COM DBA END EPS FOR GID IBM INT KEY LOG 
MON NIX NOT OFF OMS RAW ROW SAP SET SGA SHG SID SQL SYS TMP 
UID USR VAR 

 
Choose your SAP system ID carefully. Renaming is complicated and requires 
you to re-install the SAP system. 

 
If you intend to install a dialog instance on the database host, make sure that 
the DBSID is different from the dialog name, otherwise the installation will not 
continue. 
The dialog instance name is made up as follows: letter D (system setting) and 
instance number (user setting), for example D01.  

2. Make sure that the host name of your system does not: 
... 

a. Contain any special character such as a hyphen or an underscore 
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b. Exceed 13 characters in length 

Otherwise, unpredictable problems might arise using the SAP system, 
especially when using the Change and Transport System.   

 

5.8  Preparing the Installation CDs 
Use 
You use this procedure to prepare the installation CDs. 

 
We recommend that you make all required CDs available in parallel. 
The Export CDs and RDBMS CDs (if relevant) must be available in parallel. 

The following table shows the required CDs: 

Installation 
Option 

Installation Procedure Required CDs 

SAP Installation Master CD 

SAP J2EE Engine CD 

SAP IGS CD 

SAP J2EE Engine CD 

Install SAP Web AS – J2EE 
only (Central System) 

SAP IGS CD 

SAP Installation Master CD 

SAP J2EE Engine CD 

SAP Web AS 
– J2EE only 

Install a J2EE dialog 
instance for SAP Web AS – 
J2EE only 

SAP IGS CD 

SAP Installation Master CD 

Kernel CD 

Install SAP Web AS – J2EE 
Add-In (Central System) 

SAP J2EE Engine CD 

SAP Installation Master CD 

Kernel CD 

SAP Web AS – J2EE Add-
In (Distributed System): 
Prepare the central 
instance SAP J2EE Engine CD 

SAP Installation Master CD 

Kernel CD 

SAP Web AS – J2EE Add-
In (Distributed System): 
Install the central services 
instance SAP J2EE Engine CD 

SAP Installation Master CD 

Kernel CD 

SAP Web AS – J2EE Add-
In (Distributed System): 
Finalize the central instance

SAP J2EE Engine CD 

SAP Installation Master CD 

Kernel CD 

SAP Web AS 
– J2EE Add-In 

Install a dialog instance for 
SAP Web AS – J2EE Add-
In 

SAP J2EE Engine CD 
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• For the installation of a Unicode SAP system, the Unicode SAP Kernel 

CD is required. For the installation of a non-Unicode SAP system, the 
non-Unicode SAP Kernel CD is required. 

• The required CDs differ if you are installing in an existing system using 
Multiple Components in One Database (MCOD). 

• If you want to uninstall your SAP system, see section Deletion of an SAP 
System Installation. 

Procedure 
Use one of the following methods to make CDs available in parallel: 

• Before the installation: 

{ Have sufficient CD drives 

{ Copy CDs manually to local hard disks 

• During the installation: 

Use the SAPinst CD Browser dialog [Page 61], that is, you can check the entered 
location and then copy the entire CD to the path you entered in column Copy Package 
to. 

5.8.1  Using the CD Browser Dialog 
Use 
During the installation procedure SAPinst first checks and finally verifies the availability 
and location of the required installation CDs. SAPinst does this by displaying a CD Browser 
dialog, which prompts you for the file LABEL.ASC, which contains information about the 
software package to be installed. 

Procedure 
SAPinst displays the CD Browser dialog in the following situations: 

• SAPinst wants to check the availability of the software package in advance. 

In this case, you see Check Location displayed in the CD Browser window. 

Choose one of the following actions: 

Situation Action Result 

You are not yet 
sure where to 
set up the 
software 
package. 

Do not enter any Package 
Location and do not select 
Check Location. 

SAPinst skips the check and you can 
continue the installation procedure. 
However, SAPinst asks later for the 
missing LABEL.ASC (see final bullet 
point below). 

You know where 
the software 
package will be 
but have not yet 
set it up. 

Enter the path in Package 
Location but do not select 
Check Location. 

SAPinst skips checking the label 
location, but your entered package 
locations are used later for the 
installation. 
SAPinst only asks again for a 
missing LABEL.ASC if the package 
location is incorrect (see final bullet 
point below). 

You have Enter the path in Package SAPinst checks the label location 
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Situation Action Result 
already set up 
the software 
package at a 
specific location. 

Location and select Check 
Location. 

 

and displays an error message if the 
location is incorrect. 

If all locations are correct, SAPinst 
does not ask again for the 
LABEL.ASC files. 

 

• SAPinst cannot find the correct LABEL.ASC but needs the location of the software to 
process the installation now. 

You can recognize this situation because Check Location in the CD Browser window is 
empty. You must now enter the path to the correct LABEL.ASC. Otherwise, the 
installation cannot continue. 

 
When SAPinst prompts for a folder <FOLDER_NAME> on a CD, make sure that 
you enter the path to the corresponding directory on this CD 
(<CD>/<FOLDER_NAME). 

In addition, you can copy the installation package by entering a location in the column 
Copy Package to. 
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6  Installation Process 
 

Make sure that you read the Installation Checklists [Page 16] before starting 
the installation process. 

6.1 Installing the Database Software 
Use 
The MS SQL Server software has to be installed on each host in the system where you 
intend to set up an SAP instance. To prepare a host for the installation of a central, dialog or 
database instance, you have to install the database software. Depending on the type of host 
involved, you either have to install the software for the database client or server:  

• The software for the server must be installed on the host where the database runs. It 
provides all the functions required to run a relational database management system. To 
install the server software you run a batch file. 

• The software for the client must be installed on all hosts without the database. It 
enables the communication between a host and the database. When you install the 
client software you use the Microsoft SQL Server 2000 installation program. 

Procedure 
1. Log on to the host as a local administrator. 

 
For security reasons, install the MS SQL Server software on an NTFS 
partition. 

2. Insert the MS SQL Server 2000 RDBMS CD.  
For a database server, when the Microsoft SQL Server 2000 Enterprise Edition 
installation program starts, exit the program.  
For a database client, do not exit the installation program. Continue and enter the 
required information as specified in the table below in the Client Input column. 

3. For the database server, run the file SAP46C-.BAT located in the root directory of the 
RDBMS CD. 

 
SAP recommends that you perform the installation using the file SAP46C-
.BAT. 
If you nevertheless decide to use the Microsoft SQL Server installation 
program, enter information as specified in the Client Input column of the table 
below. 

 
If you mount the CD from a remote server, it must be assigned a drive letter. 
The installation writes a log file sqlstp.log to the Windows directory 
%windir% 

Input for MS SQL Server Installation Program 

Window Server Input Client Input 
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Window Server Input Client Input 

Microsoft SQL Server 2000 
Enterprise Edition 

Select SQL Server 2000 
Components. 

Select SQL Server 2000 
Components. 

Install Components 

Microsoft SQL Server 2000 
Enterprise Edition 

Select Install Database Server. Select Install Database 
Server. 

Welcome Choose Next. Choose Next. 

Computer Name  Select Local Computer. Select Local Computer. 

Installation Selection  Select Create a new instance of SQL 
Server or install Client Tools. 

Select Create a new instance 
of SQL Server or install Client 
Tools. 

User Information Enter your personal information. Enter your personal 
information. 

Software License 
Agreement 

Choose Yes. Choose Yes. 

CD-Key Enter the key specified in the file 
SAPCDKEY.txt in the root directory 
of the RDBMS CD.  

Enter the key specified in the 
file SAPCDKEY.txt in the 
root directory of the RDBMS 
CD.  

Installation Definition Select Server and Client Tools. Select Client Tools Only. 

Instance Name Select the instance you want to 
install. 

Dialog box does not appear. 

Setup Type Select Custom. Dialog box does not appear. 

Select Components Select all components except Full 
Text Search which must be 
deselected.  

Dialog box does not appear. 

Service Accounts Select Use the same account for each 
service. Auto start SQL Server 
Service. 

Select Use the Local System account. 

Dialog box does not appear. 

Authentication mode Select Windows authentication mode. 
Enter and confirm the sa login. The sa 
login is created, but cannot be used. 

Dialog box does not appear. 

Collation settings Select:  

SQL Collations  

From the dropdown list select Binary 
order for use with the 850 Multilingual 
Character Set.  

Dialog box does not appear. 

Network Libraries Leave selection unchanged and 
choose Next. 

Dialog box does not appear. 

Start Copying Files Choose Next. Choose Next. 

Choose Licensing Mode Select the mode you require. Dialog box does not appear. 
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4. Wen you have finished the installation you have to install Service Pack 3 for SQL 
Server 2000. For more information on how to get Service Pack 3, see SAP Note 
529150. 

6.1.1  Installing the Corrected MSSQL Collation 
Use 
When you install the MS SQL Server 2000 database [Page 63] for an SAP system, in the field 
Collation Settings we recommend that you select Binary order for use with the 850 
Multilingual Character Set. 

This means that all new databases and table columns are created with this collation setting. 

 
To view the default collation of MS SQL Server, use the query: 
select serverproperty('collation') 
This query returns the default collation of the overall server. When you have 
selected code page cp850, it returns: SQL_Latin1_General_CP850_BIN 

Unfortunately this collation setting does not sort Unicode data as required by an SAP system. 
To solve this problem, Microsoft provides a corrected collation, called 
SQL_Latin1_General_CP850_BIN2. The new collation is available from Microsoft as a 
hot-fix  (QFE) solution for SQL Server  

During the standard installation of the MS SQL Server database, you have to apply the hot fix 
and run the executable INSTCOLL.EXE from SAP. 

For more information on how to obtain the hot fix and INSTCOLL.EXE, see SAP Note 
600027. 

Prerequisites 
• You have installed MS SQL Server 2000 database. In the field Collation Settings, you 

selected Binary order for use with the 850 Multilingual Character Set. 

• You have installed Service Pack 3 for SQL Server 2000. 

Besides applying SP3, you do not have to make any changes on the client side (SAP 
application servers). 

 
If SP 3 is not available on the Patch CD. For more information, on how to get 
it refer to SAP Note 529150.  

• To obtain a correct collation order with MS SQL Server, you have to use the new 
collation for all new installations of a Unicode or non-Unicode SAP system with the MS 
SQL Server database. New versions of the SAPinst installation tool check for the new 
collation. 

• At present, there is no need to convert an existing SAP system to the new collation. For 
a conversion you have to perform a homogeneous system migration via R3load 
export/import. 

• An new SAP system that is using the new collation and an existing SAP system that is 
using the old collation cannot run as two databases in the same MS SQL Server 
instance. If you want to install a new system on a database server with an existing 
system you have the following options: 

{ install a new named SQL Server instance for the new system and apply the new 
collation with INSTCOLL.EXE. 
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{ convert the existing system to the new collation with a homogeneous system 
migration via R3load export/import. 

This option allows you to run both systems as two databases of a single SQL 
Server instance or as two schemas of an MCOD database. 

Procedure 
... 

1. Apply the hot fix according to the instructions from Microsoft. 

2. Download the zip file attached to SAP Note 600027 and extract it to your server. 

The zip file contains the file INSTCOLL.EXE. 

3. Open a command prompt and for a: 

{ Default instance enter: INSTCOLL.EXE 

{ Named instance enter: INSTCOLL.EXE -S<server>\<instance> (without 
any spaces after -S.) 

The collation executable starts the SQL Server service if it is not running already and 
runs several checks. When it has finished it stops the SQL Server service. You may be 
prompted to shutdown the SQL Server manually. 

After a while, the system displays a message similar to this: 
2003-02-27 19:08:31.80 spid1  index restored for 
Northwind.Employees. 

2003-02-27 19:08:31.83 spid1  index restored for 
Northwind.Categories. 

2003-02-27 19:08:31.94 spid1  index restored for 
Northwind.Customers. 

2003-02-27 19:08:32.12 spid1  index restored for 
Northwind.Suppliers. 

2003-02-27 19:08:35.47 spid1  Default collation successfully 
changed. 

2003-02-27 19:08:35.47 spid1  Recovery complete. 

4. When this output appears, press Ctrl-C to shutdown the server. 

If the SQL Server does not restart automatically, start it manually. 

5. To verify whether the MS SQL Server is configured properly, run: 
select serverproperty('collation'). 

 
You have to run INSTCOLL.EXE only once to apply the new collation. Do not 
install the collation after you have created or attached any SAP or non-SAP 
database. The INSTCOLL.EXE program checks for this and exits without 
applying the new collation. 

Result 
You can now continue with the SAP system installation and install any SAP instance on this 
server. 

6.2  Running SAPinst 
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Use 
You use this procedure to run SAPinst to install an SAP instance. 

Prerequisites 
Before you start the installation, be aware of the following:  

• When you install an SAP instance with SAPinst for the very first time on your host, you 
have to start SAPinst from the SAP Installation Master CD with the sapinst.exe 
command, as described in “Procedure” below. The SAPinst control files are copied to a 
temporary installation directory, which is %ProgramFiles%\sapinst. This directory 
is called the installation directory for the instance you are installing. 

• As the SAPinst installation directory contains important log and command files for the 
installation, make sure that you use a separate installation directory for every instance 
you are going to install. Otherwise, you might lose previous log and command files 
stored in the SAPinst installation directory, as all log files are copied to the same 
directory. 

To create a new installation directory, you have the following options: 

{ For every additional SAP instance that you want to install on the same host, you 
have to execute the newinst.cmd file in the installation directory before you 
run sapinst.exe again. By doing so, you make sure that the log and 
command files of the installed instance are moved to a subdirectory and every 
instance installation has its own log and command files. 

{ You create a new installation directory manually, as described below. 

• If you are installing a second or subsequent SAP system into an existing database, 
make sure that the database is up and running before starting the installation. For 
more information, see “Installation of Multiple Components in One Database.” 

Procedure 
... 

1. Log on to your host as a user who is a member of the local administration group. 

2. Insert the SAP Installation Master CD in your CD drive. 

3. Double-click sapinst.exe from the following path: 

<CD drive>:\SAPinst\NT\<OS> 

 
Every installation service must have its own separate installation directory 
<SAPinst_INSTDIR> every time you start SAPinst. That is, for each new 
installation with SAPinst, you must create a separate installation directory. 
Otherwise, you might lose former log and command files.  

 
If you want to create a new installation directory manually: 

i. Open a command prompt  and enter  mkdir <SAPinst_INSTDIR> 

ii. Change to the installation directory:  
cd <SAPinst_INSTDIR> 

iii. Enter <SAP Installation Master 
CD>\SAPINST\NT\<OS>\sapinst 
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SAPinst uses the ports 21212 and 21213 during the installation for 
communication with SAPinst GUI. You get an error message if one of these 
ports is already in use. In this case, you must do the following: 

• Open a command prompt. 

• Change to <CD drive>:\SAPInst\NT\<OS> and run: 
.\sapinst.exe SAPINST_DIALOG_PORT=<port> 
where <port> is an unused port on your host. 

4. Depending on your installation procedure, choose the corresponding installation task in 
the SAPinst Welcome screen to install your SAP system as listed in the tables below: 

{ SAP Web AS – J2EE only 

Installation Procedure Installation Task in SAPinst 

SAP Web AS 6.30 – J2EE only 
on one host 

J2EE only: SAP Web AS 6.30 for MS SQL 
Server (Central System) 

A J2EE dialog instance for SAP 
Web AS 6.30 – J2EE only 

J2EE only: SAP Web AS 6.30 J2EE Dialog 
Instance for MS SQL Server 

 

{ SAP Web AS – J2EE Add-In 

 
If you are installing a Unicode system, Unicode appears in the installation task 
text, for example: J2EE Add-In: Unicode Finalize SAP Web AS 6.30 for <Your 
database> (Central System). 

Installation Procedure Installation Task in SAPinst 

SAP Web AS 6.30 – J2EE Add-
In on one host 

J2EE Add-In: <Unicode> Finalize SAP Web 
AS 6.30 for MS SQL Server (Central System) 

SAP Web AS 6.30 – J2EE Add-
In on multiple hosts: 

Central services instance for a 
SAP Web AS 6.30 – J2EE Add-
In 

J2EE Add-In: <Unicode> SAP Web AS 6.30 
Central Services Instance for MS SQL Server 
(Distributed System) 

SAP Web AS 6.30 – J2EE Add-
In on multiple hosts: 

Finalize the central instance for 
SAP Web AS 6.30 – J2EE Add-
In 

J2EE Add-In: <Unicode> Finalize Central 
Instance SAP Web AS 6.30 for MS SQL 
Server (Distributed System) 

Finalize a dialog instance of 
SAP Web AS 6.30 – J2EE Add-
In 

J2EE Add-In: <Unicode> Finalize Dialog 
Instance SAP Web AS 6.30 for MS SQL 
Server 

5. Choose Next. 

6. Follow the instructions in the SAPinst dialogs, depending on the system variant [Page 
10] that you are installing: 

{ “Input for the Installation of SAP Web AS – J2EE Only” 

{ “Input for the Installation of SAP Web AS –J2EE Add-In” 
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• If SAPinst prompts you to reboot, reboot your system. 

• If SAPinst prompts you to log off from your system, log off and log on 
again. 
In both cases, the installation starts automatically and the Welcome 
screen is displayed. 

7. If you have entered all required information during the input phase, SAPinst starts the 
installation and displays the installation progress during the processing phase. 

Troubleshooting 
• If an error occurs during the input phase, SAPinst: 

{ Stops the installation 

{ Displays a dialog informing you about the error 

You can now directly view the log file by choosing View Logs 

You must abort the installation with O.K. and try to solve the problem.  

• If an error occurs during the processing phase, SAPinst: 

{ Stops the installation 

{ Displays a dialog informing you about the error 

You can now: 

{ Directly view the log file by choosing View Logs 

{ Try to solve the problem 

For more information, see the SAPinst Troubleshooting Guide in the SAP Service 
Marketplace at the Internet address:  
service.sap.com/sapinstfeedback 

{ Retry the installation by choosing Retry. 

{ Abort the installation by choosing O.K. 

For more information, see Interrupted Installation with SAPinst [Page 91]. 

6.3  Input for the Installation 
 

Make sure that you read the correct section for your installation: 
• Input for the Installation of SAP Web AS – J2EE Only [Page 69] 

• Input for the Installation of SAP Web AS – J2EE Add-In [Page 75] 
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6.3.1  Input for the Installation of SAP Web AS – 
J2EE Only 
The following tables list prompts from SAPinst, provides you with a description of the prompt 
and outlines the information you might need to enter during the input phase of the installation 
of your SAP instance. 

In this table, the following abbreviations or acronyms are used: 

Abbreviation Installation Procedure 

* All installation procedures 

CS Central system 

DI J2EE dialog instance 

 

 
The tables do not necessarily reflect the actual order in which the input 
windows appear during the installation. 

Prompts during the Installation Option SAP Web AS – J2EE only 

Window Prompt Action 

Welcome -- 

* 
• CS: 

Select J2EE only: SAP Web AS 6.30 for MS SQL 
Server (Central System). 

• DI: 

Select J2EE only: SAP Web AS 6.30 J2EE 
Dialog Instance for MS SQL Server. 

CD Browser CD Name 

* 
This dialog appears if the system wants to check or 
cannot find the file LABEL.ASC that contains the 
relevant installation information. It normally appears 
multiple times during the installation. For more 
information on the CD Browser dialog, see section 
Preparation of Installation CDs [Page 60]. 

 
When SAPinst prompts for a folder 
<FOLDER_NAME> on a CD, make sure 
that you enter the path to the 
corresponding directory on this CD ( 
<CD>/<FOLDER_NAME). 

Selecting the 
JDK Directory 

JDK Installation 
Directory 

* 

If prompted, enter the location where the Java 
Development Kit (JDK) is installed on your host. 
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Window Prompt Action 

Selecting the 
SAP System 
Parameters 

SAP System 
Parameters 

CS  

• SAP System ID: 

Enter the SAP system <SAPSID>, for example, 
C11. For more information, see Choosing an 
SAP system ID [Page 59]. 

• Database Name: 

Enter the name of the database instance 
<DBSID>. 

 
If you install a system into an existing 
database (MCOD), enter exactly the 
name of the existing database. 

• Database Host: 

If prompted, enter the name of the database 
host. To find out the host name, enter hostname 
at the command prompt of the database host. 

• Installation Drive for SAP System Files: 

Select the drive where you want to install the 
SAP system. 

Specifying the 
SAP System 
Parameters 

SAP System 
Parameters 

DI 

• SAP System ID: 

Enter exactly the SAP system ID <SAPSID> of 
the SAP Web AS. 

• Central Instance Host 

Enter the name of the central instance host. 

To find out the host name, enter hostname at 
the command prompt of the host of your central 
instance. 

Selecting the 
domain of the 
SAP System 
Accounts 

Domain 
Information for 
the SAP System 
accounts 

CS, DI 

Choose one of the following: 

• Installation in the Domain of the Current User 

• Local installation 

• Installation in a different Domain 

Database Host 

CS, DI 
Enter the database host name. Logon 

Information 

Logon Information

CS, DI 
Select the authentication mode. 

 
We strongly recommend to use 
Windows authentication mode. 

Database 
Selection 

-- 

CS  
• Select Create new database if you want to install 

the database schema. 

In this case enter the database name. 

• If you want to use an existing database, select 
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Window Prompt Action 
Use existing database. 

Database 
Selection 

-- 

DI 
This screen appears if you do not want to create a 
new database.  

• Select New database if the database does not 
yet exist and enter the database name. 

• Select Existing database, if you do not want to 
create a new database but want to use an 
existing one. 

Selecting the 
password for 
the J2EE 
Engine DB 
User 

Schema User 
Password 

CS, DI 

• CS: 

Enter and confirm the password of the schema 
user SAP<SAPSID>DB. 

• DI: 

Enter exactly the password of the schema user 
SAP<SAPSID>DB that you have specified during 
the database instance installation. Enter and 
confirm the password of the user J2EE Engine 
DB User. 

SAP System 
Information 

DI 

Dialog Instance Number 

Enter an instance number for the SAP Central 
Services instance. You can specify a value from 0 to 
97, but  not the numbers 2, 25, 43, 72, or 89. 

If more than one SAP instance is running on the 
same host, these instances must be assigned 
different numbers. 

Selecting the 
Dialog 
Instance 
parameters 

J2EE Engine 
Parameters 

DI 

• Number of J2EE Servers: 

Default value is 1. If required by your J2EE 
application, adapt this value accordingly. 

• Maximum Heap Size for Server (MB): 

Between 64 MB and 4096 MB RAM are required 
for the maximum Java heap size, depending on 
the load of your SAP system. 

 
Make sure that you do not enter a value 
larger than the maximum Java heap 
size of your platform (see the 
corresponding documentation of your 
Java Development Kit) 

Enter User 
Passwords 

Password for 
SAP 
Administrator 
Account,  

Password for 
SAP Service 
Account 

Password: 

Enter the password of these users. 
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Window Prompt Action 

DI 

Selecting the 
Parameters 
for the SAP 
Central 
Services 
Installation 

SCS Instance 
Parameters 

CS 

• SCS Instance Number: 

Enter an instance number for the SAP Central 
Services. You can specify a value from 0 to 97, 
but not the numbers 2, 25, 43, 72, or 89. 

If more than one SAP instance is running on the 
same host, these instances must be assigned 
different numbers. 

• Port number of the SAP Messaging Service: 

Enter the port number of the SAP Messaging 
Service. If you do not enter a value, the default 
port number will be used. 

J2EE Engine 
Instance 
Parameters 

CS 

Central Instance Number: 

Enter an instance number for the central instance. 
You can specify a value from 0 to 97, but not the 
numbers 2, 25, 72, or 89. 

Selecting SAP 
System J2EE 
Engine 
Parameters 

J2EE Engine 
Parameter 

CS 

• Number of J2EE Servers: 

Default value is 1. If required by your J2EE 
application, adapt this value accordingly. 

• Maximum Heap Size for Server (MB): 

Between 64 MB and 4096 MB RAM are required 
for the maximum Java heap size, depending on 
the load of your SAP system. 

 
Make sure that you do not enter a value 
larger than the maximum Java heap 
size of your platform (see the 
corresponding documentation of your 
Java Development Kit). 

Selecting 
J2EE Engine 
Passwords 

Password for 
J2EE Engine 
User 

CS 

• Enter and confirm the password of the J2EE 
Engine User Administrator. 

 
Do not use a password that contains a 
comma 

• Enter and confirm the password of the user J2EE 
Engine User guest. 

Defining 
Central 
Monitoring 
System 
Parameters

Central 
Monitoring 
System  

* 

Use Central Monitoring System and register Agent: 

Mark this option if you are using a Central Monitoring 
System and if you want this instance to be monitored 
by this system. 
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Window Prompt Action 

Connection Data 
of Central 
Monitoring 
System 

* 

• System ID: 

Enter exactly the name of the Central Monitoring 
System. 

• Instance Number: 

Enter exactly the instance number of the central 
instance of the Central Monitoring System. 

To find out the number, look under the SAP 
directory 
\usr\sap\<SAPSID>\DVEBMGS<nn>. The 
value <nn> is the number assigned to the 
central instance. 

• Application Server Host: 

Enter the name of the Central Monitoring System 
host. 

To find out the host name, enter hostname at 
the command prompt of the host of your Central 
Monitoring System. 

Parameters 

User to create 
once an TCP/IP 
destination in the 
Central 
Monitoring 
System 

* 

• Client: 

Enter the client where the user (see below) 
exists. 

 
This client should normally be the 
production client of your Central 
Monitoring System. 

• User: 

Enter a user that has the required permissions to 
create an TCP/IP destination in the Central 
Monitoring System (see the What's this? help in 
the SAPinst GUI for this dialog). For example, 
enter DDIC. 

• Password: 

Enter exactly the password of this Central 
Monitoring System user. 
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Window Prompt Action 

 Communication 
User for 
Monitoring 
Operation in the 
Central 
Monitoring 
System 

* 

• Client: 

Enter the client where the user (see below) 
exists. 

 
This client should normally be the production 
client of your Central Monitoring System. 

• User: 

Enter the communication user for monitoring 
operations in the Central Monitoring System. 

• Password: 

Enter exactly the password of this Central 
Monitoring System user. 

 

6.3.2  Input for the Installation of SAP Web AS – 
J2EE Add-In 
The following tables list prompts from SAPinst, provides you with a description of the prompt 
and outlines the information you might need to enter during the input phase of the installation 
of your SAP instance. 

In this table, the following abbreviations or acronyms are used: 

Abbreviation Installation Procedure 

* All installation procedures 

CS Central system 

DS-* Distributed system 

DS-SCS SAP central services of a distributed system 

DS-FCI Finalize central instance of a distributed system 

FDI Finalize the dialog instance 

 

 
The tables do not necessarily reflect the actual order in which the input 
windows appear during the installation. 

Prompts of the installation option SAP Web AS – J2EE Add-In 

Window Prompt Action 

Welcome -- 

* 
• CS: 

Select J2EE Add-In: <Unicode> 
Finalize SAP Web AS 6.30 for MS 
SQL Server (Central System). 

• DS-SCS: 
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Window Prompt Action 

Select J2EE Add-In: <Unicode> 
SAP Web AS 6.30 Central 
Services Instance for MS SQL 
Server (Distributed System). 

• DS-FCI: 

Select J2EE Add-In: Finalize 
Central Instance <Unicode> SAP 
Web AS 6.30 for MS SQL Server 
(Distributed System). 

• FDI: 

Select J2EE Add-In: <Unicode> 
Finalize Dialog Instance SAP Web 
AS 6.30 for MS SQL Server. 

CD Browser CD Name 

* 
This dialog appears if the system wants 
to check or cannot find the file 
LABEL.ASC that contains the relevant 
installation information. It normally 
appears multiple times during the 
installation. For more information on the 
CD Browser dialog, see section 
Preparation of Installation CDs [Page 60]. 

 
When SAPinst prompts 
for a folder 
<FOLDER_NAME> on a 
CD, make sure that you 
enter the path to the 
corresponding directory 
on this CD 
(<CD>/<FOLDER_NAME). 

Specifying the SAP 
System Parameters 

SAP System ID  

* 
Enter exactly the SAP system ID 
<SAPSID> of the existing SAP system. 

Database Host 

CS, DS-*, DI 
Enter the database host name. Logon Information 

Logon Information 

CS, DS-*, DI 
Select the authentication mode. 

 
We strongly recommend 
to use the Windows 
authentication mode. 
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Window Prompt Action 

Database Selection -- 

FCI, DS-SCS 
• Select Create new database if you 

want to install the database 
schema. 

In this case enter the database 
name. 

• If you want to use an existing 
database, select Use existing 
database. 

Database Selection -- 

FCI, DI 
This screen appears if you do not want 
to create a new database.  

• Select New database if the 
database does not yet exist and 
enter the database name. 

• Select Existing database, if you do 
not want to create a new database 
but want to use an existing one. 

SAP System 
Information 

FDI 

Dialog Instance Number: 

Enter exactly the instance number of 
the already existing dialog instance 
(ABAP). 

Selecting the Dialog 
Instance parameters 

J2EE Engine 
Parameters 

FDI 

• Maximum Heap Size for Server 
[MB]: 

Between 64 MB and 4096 MB 
RAM are required for the maximum 
Java heap size, depending on the 
load of your SAP system. 

 
Make sure that you do not 
enter a value larger than 
the maximum Java heap 
size of your platform (see 
the corresponding 
documentation of your 
Java Development Kit). 

Selecting the JDK 
Directory 

JDK Installation 
Directory 

* 

If prompted, enter the location where the 
Java Development Kit (JDK) is installed 
on your host. 

Selecting the domain 
of the SAP System 
Accounts 

Domain Information 
for the SAP System 
accounts 

CS, 

Choose one of the following 

• Installation in the Domain of the 
Current User 

• Local installation 

• Installation in a different Domain 
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Window Prompt Action 

Enter User 
Passwords 

Password for SAP 
Administrator Account,  

Password for SAP 
Service Account 

CS, 

Password: 

Enter the password of these users. 

Selecting the 
password for the 
J2EE Engine DB User 

Schema User Password 

CS, FDI 
• CS 

Enter and confirm the password of 
the database schema user 
SAP<SAPSID>DB. 

• FDI: 

Enter exactly the password of the 
database schema user 
SAP<SAPSID>DB. 

Selecting the 
Parameters for the 
SAP Central Services 
Installation 

SCS Instance 
Parameters 

CS, DS-SCS 

• SCS Instance Number: 

Enter an instance number for the 
central services instance. You can 
specify a value from 0 to 97. 

If more than one SAP instance is 
running on the same host, these 
instances must be assigned 
different numbers. 

• Port number of the SAP Messaging 
Service: 

Enter the port number of the SAP 
Messaging Service. If you do not 
enter a value, the default port 
number will be used. 

Selecting SAP 
System J2EE Engine 
Parameters 

J2EE Engine 
Parameters 

CS, DS-FCI 

• Number of J2EE Servers: 

Default value is 1. If required by 
your J2EE application, adapt this 
value accordingly. 

• Maximum Heap Size for Server 
(MB): 

Between 64 MB and 4096 MB 
RAM are required for the maximum 
Java heap size, depending on the 
load of your SAP system. 

 
Make sure that you do not enter a 
value larger than the maximum 
Java heap size of your platform 
(see the corresponding 
documentation of your Java 
Development Kit). 
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Window Prompt Action 

SAP System 
Connection Parameters 

CS, DS-FCI 

• DDIC Password: 

Enter exactly the password of user 
DDIC of the existing SAP system. 

• SAP System Client: 

Enter the client where the DDIC 
user exists. 

 
This client should 
normally be the 
production client of your 
existing SAP system. 

SAP System 
Communication 
Parameters 

User Management for 
the J2EE Engine 

CS, DS-FCI 

• SAPJSF Password: 

{ If the user SAPJSF already 
exists in the existing SAP 
Web AS, enter and confirm 
exactly its password. 

{ Otherwise, enter and 
confirm a new password for 
this user. SAPinst will then 
create this user in the 
existing SAP Web AS. 

• J2EE_ADMIN Password: 

Enter and confirm the password of 
this user. 

 
Do not use a password 
that contains a comma. 

• J2EE_GUEST Password: 
Enter and confirm the 
password of this user. 
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Window Prompt Action 

Selecting J2EE 
Engine DB 
Parameters 

-- 

 DS-FCI 
• Database Name: 

Enter exactly the name of the 
database instance <DBSID> of the 
existing SAP Web AS. 

• J2EE Database Host: 

Enter the name of the database 
host. To find out the host name, 
enter hostname at the command 
prompt of the database host. 

• ‘SAP<SAPSID>DB’ Schema 
Password: 

Enter exactly the password of this 
user that you have entered during 
the installation of the database 
schema. 

Central Monitoring 
System 

CS, DS-* 

Use Central Monitoring System and 
register Agent: 

Mark this option if you are using a 
Central Monitoring System and if you 
want this instance to be monitored by 
this system. 

Defining Central 
Monitoring System 
Parameters 

Connection Data of 
Central Monitoring 
System 

CS, DS-* 

• System ID: 

Enter exactly the name of the 
Central Monitoring System. 

• Instance Number: 

Enter exactly the instance number 
of the central instance of the 
Central Monitoring System. 

To find out the number, look under 
the SAP directory 
\usr\sap\<SAPSID>\DVEBMGS<
nn>. The value <nn> is the 
number assigned to the central 
instance. 

• Application Server Host: 

Enter the name of the Central 
Monitoring System host. 

To find out the host name, enter 
hostname at the command prompt 
of the host of your Central 
Monitoring System. 
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Window Prompt Action 

User to create once an 
TCP/IP destination in 
the Central Monitoring 
System 

CS, DS-* 

• Client: 

Enter the client where the user 
(see below) exists. 

 
This client should 
normally be the 
production client of your 
Central Monitoring 
System. 

• User: 

Enter a user that has the required 
permissions to create an TCP/IP 
destination in the Central 
Monitoring System (see the What's 
this? help in the SAPinst GUI for 
this dialog). For example, enter 
DDIC. 

• Password: 

Enter exactly the password of this 
Central Monitoring System user. 

 

Communication User for 
Monitoring Operation in 
the Central Monitoring 
System 

CS, DS-* 

• Client: 

Enter the client where the user 
(see below) exists. 

 
This client should normally be the 
production client of your Central 
Monitoring System. 

• User: 

Enter the communication user for 
monitoring operations in the 
Central Monitoring System. 

• Password: 

Enter exactly the password of this 
Central Monitoring System user. 
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7  Post-Installation Activities 
 

Make sure that you read Installation Checklists [Page 16] before performing  
the post-installation activities. 

7.1  Starting and Stopping the SAP System 
Use 
You use this procedure to check that you can start and stop the SAP system after the 
installation. You use the Microsoft Management Console (MMC) to start and stop the SAP 
system. 

 
The newly installed MMC only allows you to start or stop the SAP system 
locally on the host that you are logged on to. Later you can configure the 
MMC to enable central management of all hosts. 
For more information, choose the following in the SAP Library [Page 31]: 
Computing Center Management System → Monitoring in the CCMS 
→Microsoft Management Console: Windows 

Prerequisites 
You have logged on to the SAP system host as user <sapsid>adm. 

Procedure 

Starting the SAP System 
... 

1. To start the central services, central instance and database instance: 

{ If you have a central system – that is, central services, central instance, and 
database instance are installed on the same host: 

i. On the SAP system host, choose Start → Programs → SAP 
Management Console 

ii. Right-click the SAP system node and choose Start. 

The SAP central services, central instance, and database start. 

{ If you have a distributed system – that is, central instance, central services and 
database instance on different hosts – do the following: 

... 

i. On the central instance host, choose Start → Programs → SAP 
Management Console. 

ii. Right-click the SAP system node and choose Start. 

The SAP central services, central instance, and database start. 

2. If you have installed a (J2EE) dialog instance, repeat the above steps on the (J2EE) 
dialog instance host. 

 
If you want to start the SAP instances separately with the SAP Management 
Console, make sure that you start the instances in the following order by 
clicking on the respective node: 
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i. Central Services 

ii. Database instance 

iii. Central instance 

iv. (J2EE) dialog instance 

Stopping the SAP System 
... 

1. To stop the central services, central instance and database instance: 

{ If you have a central system – that is, central services, central instance, and 
database instance are installed on the same host: 

... 

i. On the SAP system host, choose Start → Programs → SAP 
Management Console 

ii. Right-click the SAP system node and choose Stop. 

The SAP central services and central instance stop. 

iii. Stop the database. 

{ If you have a distributed system – that is, central instance, central services and 
database instance on different hosts – do the following: 

... 

i. On the central instance host, choose Start → Programs → SAP 
Management Console. 

ii. Right-click the SAP system node and choose Stop. 

The SAP central services and central instance stop. 

iii. Stop the database. 

2. If you have installed a (J2EE) dialog instance, repeat the above steps on the (J2EE) 
dialog instance host. 

 
If you want to stop the SAP instances separately with the SAP Management 
Console, make sure that you stop the instances in the following order by 
clicking on the respective node: 

... 

i. Dialog instance, if available 

ii. Central instance 

iii. Central Services 

iv. Database instance 

7.2  Logging On to the SAP System 
Use 
You need to check that you can log on to the SAP system using the standard users. 

Prerequisites 
You have already started the SAP system and installed a front end. 
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There are two standard users in the SAP system after the installation: 

User Initial Password Client 

SAP* 06071992 000, 066 

DDIC 19920706 000 

 
During the installation, SAPinst prompts you to change the passwords for 
these standard users in client 000.  
If for any reason the SAP* and DDIC users still have initial passwords, you 
must change their passwords. Otherwise, there is a serious security risk 
because it is possible for anyone to log on to your SAP system using the initial 
passwords. 

Procedure 
... 

1. Start SAP Logon on the central instance host: 

{ SAP GUI for Windows: 

On the machine, where you have installed the front end, choose: 

Start → Programs →  SAP Front End<Release> → SAPlogon 

{ SAP GUI for Java: 

Enter the following command from the GUI installation directory: 
guilogon 

The SAP Logon dialog box appears. 

2. Create a logon entry for the newly installed system: 

Field Your Entry 

Description of 
system 

Give a meaningful description, for example, the host 
name of the central instance or the SAP system ID. 

Application Server Specify the name of the central instance host 

System number Specify the number you entered for the central 
instance during the installation. 

When you choose OK, the SAP Logon dialog box reappears and now includes an entry 
for the new system. 

3. Double-click the new system entry. 

The logon screen for the SAP system appears. 

4. Log on as user SAP*. 

7.3  Installing the SAP License 
Use 
When you install your SAP system, a temporary license is automatically installed. This 
temporary license allows you to use the system for four weeks from the date of installation. 
Before the temporary license expires, you must apply for a permanent license key from SAP. 
SAP recommends that you do so as soon as possible after you install your system. 
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Procedure 
The procedure to install the SAP license depends on the installation you have performed: 

• If you installed an SAP Web AS ABAP+J2EE system, see: 

{ Client/Server Technology → SAP License in the SAP Library [Page 31] 

{ SAP Note 94998 

 
When you install the SAP Web AS license, a license for the SAP J2EE Engine 
gets installed automatically. 

 
You can install several licenses, one for each host running a message server. 
For example, on Windows, this applies if you have an installation with 
Microsoft Cluster Server (MSCS). The SAP system then searches for the 
current license. 

• If you installed an SAP Web AS J2EE system, see J2EE Technology in SAP Web 
Application Server → Administration Manual Æ Installation Information Æ Licensing of 
the SAP J2EE Engine in the SAP Library [Page 31]. 

7.4  Installing the SAP Online Documentation 
Use 
SAP currently provides an HTML-based solution for the online documentation, the SAP 
Library. The Application Help, Glossary, Implementation Guide (IMG), and Release Notes are 
delivered in HTML format. You can display the documentation with a Java-compatible Web 
browser on all front-end platforms supported by SAP. 

Procedure 
Install the SAP online documentation (SAP Library) in your SAP system as described in the 
README.TXT file contained in the root directory of the online documentation CDs, delivered 
as part of the installation package. 

For other ways to access the SAP Library, see the Accessing the SAP Library [Page 31] 
section in this documentation. 

7.5  Checking the SAP J2EE Engine 
Documentation 
Use 
You need to check important information about the SAP J2EE Engine in the SAP Library. 

Prerequisites 
Open J2EE Technology in SAP Web Application Server in the SAP Library [Page 31]. 

Procedure 
Beside other information, this section of the SAP Library contains the following manuals. 
Check them for information that is relevant for running your SAP system. 
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Manual Contents 

Architecture Manual In the Architecture Manual first the J2EE cluster architecture of 
the SAP Web AS, central services, load balancing, and high 
availability are described. Then follows an explanation of the 
system architecture of the SAP J2EE Engine. A further section 
explains how the SAP NetWeaver Developer Studio – the SAP 
development infrastructure for Java – is structured and 
describes the integration of the SAP NetWeaver Developer 
Studio into the entire SAP development infrastructure. 

Administration Manual The Administration Manual contains all the administration 
information for the SAP J2EE Engine. The main topics are 
configuration and administration, and monitoring and 
performance. Other important topics are security of the J2EE 
Engine and the description of the server infrastructure. The 
manual is supplemented with tips about handling errors. 

 
Especially make sure that you check the 
mandatory post-installation procedures listed in 
the Administration Manual under Installation 
Information Æ Post-Installation Procedures. 

Development Manual This manual covers the Java development environment – the 
SAP Netweaver Developer Studio – and explains how to design 
Web-based user interfaces and business objects using the SAP 
NetWeaver Developer Studio. The section Advanced 
Programming provides you with an extensive introduction to the 
Java programming environment and explains the areas, 
deployment, sessions, services and interfaces. 

Reference Manual This manual contains descriptions of the configuration 
parameters of the J2EE Engine, the J2EE Engine shell 
commands and the SAP J2EE Engine deployment descriptors. 

Migration Manual This manual contains all the information you need to migrate an 
application created in SAP Web Application Server 6.20. 

 

7.6  Performing a Full Backup 
Use 
You must perform an offline full backup at the end of the installation. 

Prerequisites 
• You have completed client maintenance (for example, client copy). 

• You have stopped: 

{ The SAP system 

{ SAP-related services (SAP<SAPSID>_<instance> and SAPOSCol) 

{ The database 

• You are logged on as user <sapsid>adm. 
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• You have shut down the SAP system and database. 

Procedure 
... 

1. Save the registry: 

a. Choose Start → Programs → Accessories → System Tools → Backup 

b. Choose Emergency Repair Disk. 

c. The Emergency Repair Diskette dialog box appears. 

d. Select Also Backup the Registry to the Repair directory… 

When you confirm your entry, the registry is written to diskette. 

2. Save the system state data: 

a. Choose Start → Programs → Accessories → System Tools → Backup. 

b. Choose Backup Wizard → Next. 

c. Select Only back up the System State data and choose Next. 

d. In Where to Store the Backup, select the Backup media type and enter the 
Backup media or file name. 

e. Choose Next.   

f. Check the information displayed and choose Finish to start the backup. 

3. Back up all SAP-specific and all database-related directories: 

a. Choose Start → Programs → Accessories → System Tools → Backup. 

b. Choose Backup Wizard → Next. 

c. Select Back up selected files, drives, or network data and choose Next. 

d. In What to back up, select the Windows directory and all SAP and database-
related directories, including: 
\USR\SAP 

\USR\SAP\TRANS 

<HOMEDIR> of <sapsid>adm 

\%WINDIR% 

 
The directory \USR\SAP\TRANS is only required for SAP systems that have 
the ABAP engine installed. 

e. Choose Next. 

f. In Where to Store the Backup, select the Backup media type and enter the 
Backup media or file name for the backup. 

g. Choose Next. 

h. Check the information displayed and then choose Finish to start the backup. 
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7.7  Changing Passwords of Created Users 
Use 
You need to change the password of the user that SAPinst creates during the installation. 
The table below lists this user. You also need to remove the contents of the installation 
directory and store them securely because otherwise they might represent a security risk:  
service.sap.com/securityguide 

 
Make sure that you perform this procedure before the newly installed SAP 
system goes into production.  

Procedure 
... 

1. Change the password of this user according to the SAP Security Guide. 

For more information, see the SAP Service Marketplace at the Internet address: 
service.sap.com/securityguide 

 
• SAP system users might exist in more SAP system clients than listed 

below (for example, if a user was copied as part of the client copy [Page 
31]. 

• We strongly recommend that you change the initial passwords even if 
SAPinst prompted for a new password during the installation procedure. 

 

User Type User Comment 

SAP system user SAPJSF User exists at least in SAP system client 
that you have specified during the 
installation (see Input for the Installation 
[Page 69]). 

2. For security reasons we recommend that you remove all relevant files from the SAPinst 

a. installation directory, <SAPinst_INSTDIR>, and keep them in a safe place: 
Enter the following command: 
<SAPinst_INSTDIR>/newinstall.sh 

This command creates a new subdirectory under <SAPinst_INSTDIR> 
containing all files that might represent a security risk. 

b. Copy the newly created subdirectory to another medium and keep this in a safe 
place. 

c. Remove the newly created subdirectory from the installation host. 
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8  Additional Information 
For information on how to delete an SAP installation, see: 

Deletion of an SAP Installation [Page 97] 

For background information on the security concept implemented for SAP on Windows, see: 

SAP System Security on Windows [Page 101] 

8.1  Remote Installation with SAPinst 
Purpose 
You can run the SAPinst GUI in standalone mode to perform a remote installation. 

This enables you to install an SAP system on another host (the remote host) while monitoring 
the installation with the SAPinst GUI on your local Windows or UNIX computer (the local 
host). 

Prerequisites 
• Make sure that you have performed the preparation activities for your local host 

(SAPinst GUI host) and your remote host. 

For more information, see Installation Preparations in this documentation. 

• Both computers are in the same network and can ping each other. 

To test this: 

{ Log on to your remote host and enter the command ping <local host>. 

{ Log on to the local host and enter the command ping <remote host>. 

• SAPinst ports 

SAPinst uses the ports 21212 and 21213 during the installation for communication with 
the SAPinst GUI. If one of these ports is already used by another service, SAPinst 
aborts the installation with an appropriate error message. 

In this case, you must start SAPinst or the SAPinst GUI from the command prompt as 
follows: 

 
In the following commands, <free_port_number> defines an unused port 
number. Since SAPinst also uses <free_port_number> + 1, this must 
also be free. 
For example, if you enter 60000 as <free_port_number>, SAPinst uses 
the ports 60000 and 60001. 

{ UNIX: 

� SAPinst: ./sapinst 
SAPINST_DIALOG_PORT=<free_port_number> 

� SAPinst GUI: ./sapinstgui.sh -port <free_port_number> 

{ Windows: 

� SAPinst: sapinst SAPINST_DIALOG_PORT=<free_port_number> 

� SAPinst GUI: sapinstgui.bat -port <free_port_number> 
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Process Flow 
... 

1. You start the SAPinst server on your remote host. 

2. You start the SAPinst GUI on your local host. 

3. You perform the installation using the SAPinst GUI. 

For more information, see: 

• Starting SAPinst on the Remote Host [Page 90] 

• Starting SAPinst GUI on the Local Host [Page 91] 

8.1.1  Starting SAPinst on the Remote Host 
Use 
You use this procedure to run SAPinst on the remote host when you want to run SAPinst as 
a remote installation [Page 89]. The remote host is the host where you want to install the SAP 
system. 

Procedure 

Your Remote Host Runs on a Windows Platform 
... 

1. Log on to your remote host as a user who is a member of the local administration 
group. 

2. Insert the installation CD in your CD drive. 

3. Create <SAPinst_INSTDIR> and change to this directory. 

4. Enter the following command from the Windows command prompt: 
<CD drive>:\SAPinst\NT\<OS>\sapinst.exe SAPINST_NO_GUISTART=true 

SAPinst now gets started without the SAPinst GUI and waits for the connection to the 
SAPinst GUI. 

5. Start the SAPinst GUI on your local host, as described in Starting SAPinst GUI on the 
Local Host [Page 91]. 

Your Remote Host Runs on a UNIX Platform 
... 

1. Log on to your remote host as user root. 

2. Mount the installation CD. 

3. Create <SAPinst_INSTDIR> and change to this directory. 

4. Enter: 
<Installation CD>/SAPINST/UNIX/<OS>/   \ 
   sapinst SAPINST_NO_GUISTART=true 

SAPinst now gets started without the SAPinst GUI and waits for the connection to the 
SAPinst GUI. The following message is displayed: 
guiengine: waiting for connect... 

5. Start the SAPinst GUI on your local host, as described in Starting SAPinst GUI on the 
Local Host [Page 91]. 
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8.1.2  Starting SAPinst GUI on the Local Host 
Use 
You use this procedure to run SAPinst GUI on the local host when you want to run SAPinst 
as a remote installation [Page 89]. The local host is the host where you want to control the 
installation with the SAPinst GUI. 

Procedure 

Your Local Host Runs on a Windows Platform 
... 

1. Log on to your local Windows host. 

2. Insert the installation CD into your CD drive. 

3. Enter the following command from the Windows command prompt: 
<CD drive>:\SAPinst\NT\<OS>\startinstgui.bat 

The SAPinst GUI now gets started and connects automatically to the host that is 
waiting for a connection. The Welcome screen is displayed. 

 
If prompted, enter the following parameters: 

• Hostname : Enter the host name of the remote computer. 
• Port: Enter the same port number as SAPinst uses on the remote host. 

4. Perform the installation from your local host. 

Your Local Host Runs on a UNIX Platform 
... 

1. Log on to your local UNIX host as user root. 

2. Mount your installation CD. 

3. Change to the following directory: 
<Installation CD>/SAPINST/UNIX/<OS> 

4. Enter: startInstGui.sh 

The SAPinst GUI now gets started and connects automatically to the host that is 
waiting for a connection. The Welcome screen is displayed. 

 
If prompted, enter the following parameters: 

• Hostname : Enter the host name of the remote computer. 
• Port: Enter the same port number as SAPinst uses on the remote host. 

5. Perform the installation from your local host. 

8.2  Interrupted Installation with SAPinst 
Purpose 
SAPinst does not abort the installation in error situations. Therefore, you can continue an 
interrupted installation when you have: 

• Not canceled the installation 

• Already canceled the installation 
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Prerequisites 
You have solved the problem that caused the error situation. 

Process Flow 
• You have not canceled the installation 

That is, the error dialog box is still displayed and SAPinst is waiting for your input. You 
proceed as follows: 

In the error dialog box, you choose Retry. 

SAPinst now retries the installation step. 

• You have already canceled the installation. 

That is, the installation was aborted.  

{ If you have cancelled the installation after you have finished the input phase and 
SAPinst has already started the installation phase, you can continue the 
installation [Page 92]. 

Since SAPinst records the installation progress in the keydb.xml file, you can 
continue the installation from the failed step without repeating previous steps. 

{ If you have cancelled the installation during the input phase, you have to restart 
the installation [Page 93] from the beginning, that is, SAPinst uses the default 
keydb.xml file as delivered. 

 
In some cases, you must de-install already installed components, before 
repeating the installation from the beginning. For example, this applies to an 
SAP system installation. For more information, see the description on how to 
de-install a component in the corresponding installation guide. 

8.2.1  Continuing an Interrupted Installation with 
SAPinst 
Use 
You use this procedure if you have finished the input phase and you have decided to 
continue an interrupted installation [Page 91] with SAPinst. That is, SAPinst continues the 
installation at the point where it stopped. 

Procedure 
Windows 
... 

1. Check if a SAPinst GUI Java process is still running. 

2. If a process is still running, look for javaw.exe under Processes in your Task 
Manager and kill it. 

3. Start SAPinst from your SAP Master CD. 

UNIX 
... 

1. Check if a SAPinst GUI Java process named java is still running: 
ps -efl | grep java 
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If so, kill it. 

2. Make sure that all environment variables are set as described in the corresponding 
installation documentation. 

3. Start SAPinst from SAP Master CD. 

8.2.2  Restarting an Interrupted Installation with 
SAPinst 
Use 
You use this procedure if you have decided to restart an interrupted installation [Page 91] 
with SAPinst from the beginning. In this case, SAPinst uses the default keydb.xml file as 
delivered. 

Procedure 
Windows 
... 

1. Check if a SAPinst GUI Java process is still running. 

2. If a process is still running, look for javaw.exe under Processes in your Task 
Manager and kill it. 

3. Do one of the following: 

{ Execute newinst.cmd in the installation directory before you run 
sapinst.exe from the SAP Master CD. 

{ If you do not want to keep the former log files, delete the installation directory 
%ProgramFiles%\sapinst, before you run sapinst.exe from the SAP 
Master CD. 

UNIX 
... 

1. Check if a SAPinst GUI Java process named java is still running: 

ps -efl | grep java 

If so, kill it. 

2. Do one of the following: 

{ Create a new installation directory and restart the installation from the SAP 
Master CD. 

{ Prepare the new installation by running the following command from your 
installation directory <SAPinst_INSTDIR>: 
./newinstall.sh 

This command copies current log and command files to the backup directory 
<SAPinst_Dir>/log<month>_<date><time> that indicates the date and 
time of the backup. You can then start SAPinst with reset XML files from the 
SAP Master CD. 
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8.3  Additional Information about the SAP 
J2EE Engine 

 
For more information, also see J2EE Technology in SAP Web Application 
Server in the SAP library [Page 31]. 

File System Structure of the SAP J2EE Engine Installation 
After the installation of the SAP J2EE Engine, the following file system structure applies for 
the SAP J2EE Engine (j2ee) and its Software Deployment Manager (SDM, see The 
Software Deployment Manager in this section): 

/ or <DRIVE>

usr

sap

<SAPSID>

j2ee SDM

... ...

/ or <DRIVE>

usr

sap

<SAPSID>

<Instance Name>

j2ee

...

Central Instance           Dialog Instance

<Instance Name>

 

 
For example, the file system structure might look as follows: 

• On a central instance with SAP system ID C11 and instance name 
DVEBMGS00 on UNIX, the SAP J2EE Engine is installed to 
/usr/sap/C11/DVEBMGS00/j2ee and the corresponding SDM is 
installed to /usr/sap/C11/DVEBMGS00/SDM. 

• On a dialog instance with instance name D01 on Windows, the SAP 
J2EE Engine is installed to c:\usr\sap\C11\D01\j2ee. No SDM is 
installed. 

 
SAP Web AS J2EE system only: 
The instance name (instance ID) of the central instance is 
JC<Instance_Number>, the instance name of a J2EE dialog instance is 
J<Instance_Number>. 
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Starting the Administration Tool of the SAP J2EE Engine 

 
For more information about the administration tool of the SAP J2EE Engine, 
see J2EE Technology in SAP Web Application Server Æ Administration 
Manual Æ Server Administration Æ SAP J2EE Engine Administration Tools Æ 
Visual Administrator in the SAP Library [Page 31]. 

... 

1. For the user who will run the administration tool (for example, <SAPSID>adm), make 
sure that the JAVA_HOME environment variable contains the path to the Java 
Delelopment Kit (JDK) of the SAP J2EE Engine. 

2. On UNIX, make sure that your DISPLAY environment variable is set to 
<host_name>:0.0, where <host_name> is the host on which the administration tool 
will be displayed. 

Used Shell Command 

Bourne Shell (sh) DISPLAY=<host_name>:0.0 

export DISPLAY 

C Shell (csh) setenv DISPLAY <host_name>:0.0 

Korn Shell (ksh) export DISPLAY=<host_name>:0.0 

 

3. Enter the following command to start the administration tool: 

{ UNIX: 
/usr/sap/<SAPSID>/<Instance_Name>/j2ee/admin/go 

{ Windows: 
<Drive>:\usr\sap\<SAPSID>\<Instance_Name>\j2ee\admin\go.bat 

Deactivation of the SAP J2EE Engine 

 
This section is not valid for SAP Web AS J2EE systems. 

After the installation, the SAP J2EE Engine is activated. If you do not want to use the SAP 
J2EE Engine, you can deactivate it by setting the parameter rdisp/j2ee_start to 0 in the 
instance profile of every installed SAP instance. To do this, edit the correct file for your 
platform: 

• UNIX – log on first as user root 

 <sapmnt>/profile/<SAPSID_INSTANCENAME_HOSTNAME> 

• Windows 
<DRIVE>:\usr\sap\<SAPSID>\sys\profile\<SAPSID_INSTANCENAME_HOSTN
AME> 

• IBM eServer iSeries 
/sapmnt/<SAPSID>/profile/<SAPSID_INSTANCENAME_HOSTNAME> 

 
This is a sample extraction of an edited UNIX instance profile: 
... 
rdisp/max_priv_time = 0 
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rdisp/j2ee_start = 0 
exe/j2ee = /usr/sap/MB2/DVEBMGS45/j2ee/cluster/  \ 
   dispatcher/go 
rdisp/j2ee_timeout = 60 
rdisp/j2ee_error = 10 
icm/HTTP/j2ee_0 = PREFIX=/,HOST=localhost,  \ 
   CONN=0-10,PORT=33609 
rsdb/ntab/dblength2_wa = 1 
... 

The Software Deployment Manager 
Every SAP J2EE Engine on a central instance and every SAP J2EE Engine installed 
standalone requires a Software Deployment Manager (SDM). SDM is a tool with which you 
can manage and deploy SAP software packages. 

 
To manage and deploy SAP applications in programming languages other 
than ABAP, the SDM is integrated into the SAP installation tool SAPinst. 
Therefore, the current section only contains background information. 

Software Deployment Archive (SDA) 

The Software Deployment Archive (SDA) is the delivery format for SAP applications in 
programming languages other than ABAP. It is a ZIP-compatible archive format that can be 
used as a container for other archives. The SDA contains the manifest information - that is, 
package-related data - of its archives (such as jar, war) and an SAP manifest, which 
contains additional software logistics information.  

 
The EAR archive is a special case in the J2EE context. If an EAR archive 
contains an SAP manifest, it is also an SDA. The SDM recognizes the EAR 
archive as an SDA, but does not rename the archive extension as 
<archive_name>.sda. 

An SDA is the smallest unit that you can deploy. Furthermore, the SDA is the smallest unit for 
which patches can be created and delivered.  

Software Component Archive (SCA) 

A Software Component Archive (SCA) is the physical representation of a version of a 
software component. It contains a specific number of SDAs, whose quantity describes a 
precisely-defined version level.  

A SCA update always results in a new version level of the software component. 

Deployment 

The deployment is the final step in the software delivery process; it involves the deployment 
of available software packages - SDAs or SCAs - in the runtime environment of the SAP 
systems. 

When deploying SDAs/SCAs, the Software Deployment Manager stores the data in the SDM 
Repository, where it then manages the installed archives. The SDM recognizes 
dependencies between archives and provides support when you install and maintain shared 
applications. 
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8.4  Deletion of an SAP System Installation 
(J2EE) 
Purpose 
This section describes how to delete a (J2EE) dialog instance or a J2EE Add-In installation. 

 
If you delete a J2EE Add-In installation, the original SAP system (ABAP) is 
not deleted. 

 
This description assumes that the installation of your SAP system has been 
performed using SAP standard tools according to the installation 
documentation. 

Process Flow  
If you delete network-wide users, groups or service entries in an environment 
with Network Information System (NIS), other SAP installations might also be 
affected. Make sure that the users, groups, and service entries to be deleted 
are no longer required. 

Deleting a J2EE Dialog Instance 
You delete the J2EE dialog instance. For more information, see Deleting an SAP Instance 
[Page 98]. 

Deleting a J2EE Add-In Installation 
... 

1. Stop the central services instance and all J2EE dialog instances of your SAP system: 
... 

a. Log on to the corresponding instance host as user <sapsid>adm. 

b. Execute the following command: 

� To stop the central services instance named <SCSxx>: 
stopsap <SCSxx> 

� To stop a J2EE dialog instance named <Dxx>: 
stopsap <Dxx> 

2. Stop the SAP J2EE Engine of the central instance: 

a. Log on to your SAP system. 

b. Call transaction SMICM. 

c. Choose Administration → J2EE Server → send hard shutdown. 

 
You do not need to stop the central instance. 

3. Remove the lines beginning with the following parameter names from the default profile 
\usr\sap\<SAPSID>\SYS\profile\default.pfl: 

j2ee\dbname =  
j2ee\dbtype =  
j2ee\dbhost =  
j2ee\dbadminurl = 
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4. Remove the lines beginning with the following parameter names from the central 
instance profile and from all J2EE dialog instance profiles 
(\usr\sap\<SAPSID>\SYS\profile\<SAPSID>_<INSTANCE_NAME>_<host_na
me>): 

exe\j2ee =  
rdisp\j2ee_start_control =  
rdisp\j2ee_start =  
rdisp\j2ee_timeout =  
rdisp\frfc_fallback =  
jstartup\trimming_properties =  
jstartup\instance_properties =  
jstartup\protocol =  
exe\jlaunch = 

5. Add a comment sign to the front of the lines beginning with the following parameter 
names in the start profiles of the central instance and of all J2EE dialog instances 
(<drive>:\usr\sap\<SAPSID>\SYS\profile\START_<INSTANCE_NAME>_<host
_name>): 

_DB =  
Start_Program_00 = 

6. Delete the SAP central services, as described in Deleting an SAP Instance [Page 98]. 

7. Delete the J2EE database schema (see the corresponding section below).´ 

8. Delete the following directories (<xx> is the central instance number): 

{ \usr\sap\<SAPSID>\DVEBMGS<xx>\SDM 

{ \usr\sap\<SAPSID>\DVEBMGS<xx>\j2ee 

Deleting a Complete SAP System 
... 

1. You delete all (J2EE) dialog instances, the central services instance, and the central 
instance. For more information, see Deleting an SAP Instance [Page 98]. 

2. You delete the MS SQL Server database and the J2EE Engine Database Schema 
Page 101]. 

8.4.1  Deleting an SAP Instance 
Use 
You use this procedure to delete the (J2EE) dialog instance and the SAP central services or 
the central instance. 

Prerequisites 
The SAP system is stopped and the database is shut down.  

Procedure 

 
We recommend to use perform this procedure only, if you have performed a 
full backup of your SAP system.  
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Using the SAP Uninstall Program  
You use this option to remove a complete SAP system or select different instances to be 
deleted. 

 
If you want to delete a J2EE dialog instance in an SAP Web AS – J2EE Add-
In installation which is installed on the same host than the central instance, 
you have to delete the J2EE Add-In installation as described in Deletion of an 
SAP System Installation (J2EE) [Page 97]. 

... 

1. Log on as a user with domain administration rights. 

2. Choose Start → Settings → Control Panel → Add/Remove Programs. 

3. The Add/Remove Programs dialog box appears. 

4. Find the SAP entries. 

 
Each SAP instance that is installed on the computer is listed with an entry like 
SAP Application Server for System <SAPSID>instance 

5. Choose Remove. 

The SAP Uninstall Wizard starts. 

6. Choose Next in the Welcome window. 

The dialog box Uninstalling SAP System appears for you to select an uninstall method: 

 
Depending on your selection, note the following when using the checkbox to 
delete an SAP instance: 

• If your checkbox is marked gray, you delete or uninstall the following: 

• The SAP instance directory, for example: 
usr\sap<SAPSID>\D00 

• Services, for example SAP<SAPSID>_00 

• The whole system directory, for example 
usr\sap\<SAPSID>\* 

• If your checkbox is marked black, you delete or uninstall the following: 

• The SAP instance directory, for example: 
usr\sap<SAPSID>\D00 

• Services, for example SAP<SAPSID>_00 

• The whole system directory, for example 
usr\sap\<SAPSID>\* 

• Local and domain user accounts 

• If you have different SAP instances that use the same <SAPSID>, you 
can delete the instance directory only. 

 

Uninstall 
Method 

Action 
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Uninstall 
Method 

Action 

Typical Select this if you want to completely uninstall the selected 
SAP instance(s). 

 
• If you uninstall the central instance, the 

checkbox is marked black. 

• If you uninstall the dialog instance, the 
checkbox is marked gray. 

Choose Finish to delete the SAP instance. 

Complete  Select this if you want to uninstall all the SAP instances that 
are installed on the local computer.  

 
• All instances are marked with a black 

checkbox. 

• This uninstall method removes all the 
SAP instances listed in the Add/Remove 
Programs Properties dialog box, 
regardless of the highlighted selection. 

Choose Finish to delete all local SAP instances. 

Select Custom and choose Next to access the Select 
Components dialog box that allows you to mark the 
instances you want to remove.  

In the Select Components dialog box, use the check box 
beside an instance to indicate whether only the instance 
involved or the entire system, with global accounts, is to be 
deleted. 

Uninstall instance-independent components 

Select this additional option, if there is no other SAP 
system on the local machine. With this option you can 
delete for example the saposcol program. 

Add 

Choose this option to manually add instances you want to 
delete if they do not appear on the list. 

Custom 

Finish  

Choose to start the deletion. 

 

The wizard informs you when the SAP system or selected instances have been deleted 
successfully. 
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8.4.2  Deleting the MS SQL Server Database and 
the J2EE Engine Database Schema 

 
If you have multiple components installed in one database (MCOD), delete the 
database only if you want to delete all contained components as well. 
Otherwise, delete components on a selective basis (see SAP Note 399910). 

For more information on how to delete the  MS SQL Server database and the J2EE database 
schema, refer to SAP Note 639710. 
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